
MultiQuantTM MD 3.0.3 Software

Reference Guide

June 2017IVD-IDV-06-0904-C



This document is provided to customers who have purchased SCIEX equipment to use in the operation
of such SCIEX equipment. This document is copyright protected and any reproduction of this document
or any part of this document is strictly prohibited, except as SCIEX may authorize in writing.

Software that may be described in this document is furnished under a license agreement. It is against
the law to copy, modify, or distribute the software on any medium, except as specifically allowed
in the license agreement. Furthermore, the license agreement may prohibit the software from being
disassembled, reverse engineered, or decompiled for any purpose. Warranties are as stated therein.

Portions of this document may make reference to other manufacturers and/or their products, which
may contain parts whose names are registered as trademarks and/or function as trademarks of their
respective owners. Any such use is intended only to designate those manufacturers' products as
supplied by SCIEX for incorporation into its equipment and does not imply any right and/or license
to use or permit others to use such manufacturers' and/or their product names as trademarks.

SCIEX warranties are limited to those express warranties provided at the time of sale or license of
its products and are SCIEX’s sole and exclusive representations, warranties, and obligations. SCIEX
makes no other warranty of any kind whatsoever, expressed or implied, including without limitation,
warranties of merchantability or fitness for a particular purpose, whether arising from a statute or
otherwise in law or from a course of dealing or usage of trade, all of which are expressly disclaimed,
and assumes no responsibility or contingent liability, including indirect or consequential damages,
for any use by the purchaser or for any adverse circumstances arising therefrom.

For In Vitro Diagnostic Use.
Rx only.
Not available in all countries. Contact a SCIEX Sales Representative for details.

AB Sciex is doing business as SCIEX.

The trademarks mentioned herein are the property of AB Sciex Pte. Ltd. or their respective owners.

AB SCIEX™ is being used under license.

© 2017 AB Sciex

AB Sciex Netherlands B.V.
1e Tochtweg 11,
2913LN Nieuwerkerk aan den Ijssel
Netherlands

AB Sciex Pte. Ltd.
Blk 33, #04-06
Marsiling Ind Estate Road 3
Woodlands Central Indus. Estate.
SINGAPORE 739256

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C2 / 169



Chapter 1 Introduction to the Software....................................................................................................7
Software Help....................................................................................................................................................................7
File Types...........................................................................................................................................................................8
Contact Us.........................................................................................................................................................................8
Technical Support..............................................................................................................................................................8

Chapter 2 File Menu....................................................................................................................................9
Import a Quantitation Method.........................................................................................................................................10
Export Submenu...............................................................................................................................................................11

Export Results Tables.................................................................................................................................................11
Export Results Table-Metric.......................................................................................................................................13

Transfer to LIMS...............................................................................................................................................................14

Chapter 3 Edit Menu.................................................................................................................................15
Modify Results Table Method..........................................................................................................................................17
Project Units & Calibration Defaults.................................................................................................................................18
Project Secure Export Settings.........................................................................................................................................18

Chapter 4 Process Menu...........................................................................................................................19
Export Calibration............................................................................................................................................................20
Import External Calibration..............................................................................................................................................20

Chapter 5 Audit Trail Menu......................................................................................................................22
Audit Trail Viewer............................................................................................................................................................22

View the Audit Trail Results in the Audit Trail Viewer...............................................................................................22
Perform a Keyword Search.........................................................................................................................................24
Filter Audited Events..................................................................................................................................................24
Export the Audit Trail Viewer.....................................................................................................................................26
Print the Audit Trail Viewer........................................................................................................................................26

Audit Trail Manager.........................................................................................................................................................26
About Audit Maps............................................................................................................................................................27

Create an Audit Map.................................................................................................................................................27
Change the Audit Map...............................................................................................................................................30
Edit the Audit Map.....................................................................................................................................................31

View the Embedded Audit Configuration.........................................................................................................................34

Chapter 6 Help Menu................................................................................................................................36

Chapter 7 Results Tables...........................................................................................................................37
Components & Groups List..............................................................................................................................................38
Results Table Right-Click Menu.......................................................................................................................................39
Apply Current Analyte's Actual Concentrations to All......................................................................................................40

MultiQuantTM MD 3.0.3 SoftwareReference Guide
3 / 169IVD-IDV-06-0904-C

Contents



Column Settings...............................................................................................................................................................40
Sample Type Filter............................................................................................................................................................42
View Hidden Rows...........................................................................................................................................................42
Results Table Dialogs.......................................................................................................................................................43

Select Samples...........................................................................................................................................................43
Select Method............................................................................................................................................................44
Select Representative Sample....................................................................................................................................45
Define Components...................................................................................................................................................46
Define Integration......................................................................................................................................................49
Outlier Settings..........................................................................................................................................................52

Results Table Columns.....................................................................................................................................................54

Chapter 8 Peak Review.............................................................................................................................62
Manual Integration..........................................................................................................................................................62
Apply...............................................................................................................................................................................63
Tips for Reviewing Peaks.................................................................................................................................................63
Peak Review Right-Click Menu .......................................................................................................................................64

Peak Review Options Dialog: Appearance Tab..........................................................................................................65
Peak Review Options Dialog: Zooming Tab...............................................................................................................67
Set Peak Review Title Format.....................................................................................................................................68
Copy Parameters........................................................................................................................................................69
Paste Parameters.......................................................................................................................................................69
Set Peak to 'Not Found'.............................................................................................................................................70
Use Peak....................................................................................................................................................................70
Update Quantitation Method for Component............................................................................................................70
Update Quantitation Method for Group....................................................................................................................70
Apply Integration Parameters to Sample Within Group.............................................................................................71
Revert Peak to Original Method.................................................................................................................................71
Revert All Peaks for Component................................................................................................................................71

Chapter 9 Side-by-side Sample Review...................................................................................................72
Perform a Side-by-Side Sample Review............................................................................................................................72

Chapter 10 Calibration Pane.....................................................................................................................74
Regression Options Dialog...............................................................................................................................................74
Calibration Tips................................................................................................................................................................75
Calibration Right-Click Menu...........................................................................................................................................76

Chapter 11 Statistics Tables......................................................................................................................77
Statistics Table Tips..........................................................................................................................................................78
Statistics Table Right-Click Menu.....................................................................................................................................78

Chapter 12 Metric Plots............................................................................................................................79
Generate a Metric Plot.....................................................................................................................................................79
Save Metric Plot Settings.................................................................................................................................................79
Metric Plot Tips................................................................................................................................................................79
Metric Plot Right-Click Menu...........................................................................................................................................80
Regression Dialog............................................................................................................................................................81

Chapter 13 Quantitation Method Editor.................................................................................................83

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C4 / 169

Contents



Components Tab..............................................................................................................................................................83
Groups Submenu.......................................................................................................................................................84
Internal Standards Submenu......................................................................................................................................86

Integration Tab ...............................................................................................................................................................87
Highlight Components Dialog....................................................................................................................................88
Update Retention Time Dialog...................................................................................................................................88

Outlier Settings Tab ........................................................................................................................................................89

Chapter 14 Quantitation Analysis Workflow Tutorial...........................................................................91
About Calibration Curves.................................................................................................................................................91
Prerequisites....................................................................................................................................................................91
Modify the Columns Shown in the Results Table.............................................................................................................91
Process Data Using the SignalFinderTM Integration Algorithm.........................................................................................93

Set the Peak Integration Parameters..........................................................................................................................93
Create a Results Table...............................................................................................................................................94
Review Peaks.............................................................................................................................................................98
Modify the Calibration Curve.....................................................................................................................................99
Review Sample Statistics.........................................................................................................................................100

Process Data Using the MQ4 Integration Algorithm......................................................................................................101
Set the Peak Integration Parameters........................................................................................................................101
Create a Results Table.............................................................................................................................................102
Review Peaks...........................................................................................................................................................106
Modify the Calibration Curve...................................................................................................................................108
Review Sample Statistics.........................................................................................................................................108

Integration Algorithms...................................................................................................................................................109
About the SignalFinder Integration Algorithm.........................................................................................................110
SignalFinderTM Integration Algorithm Parameters...................................................................................................113
MQ4 Integration Algorithm Parameters...................................................................................................................117

Optional Tasks...............................................................................................................................................................120
Create Metric Plots..................................................................................................................................................120
Create Custom Columns..........................................................................................................................................121
About Quantitation Method Files and Embedded Methods.....................................................................................121

Appendix A Integration Algorithm Parameters....................................................................................122
SignalFinder Integration Algorithm Parameters.............................................................................................................122
MQ4 Integration Algorithm Parameters.........................................................................................................................125

Appendix B Regression Equations.........................................................................................................128
Weighting Factors..........................................................................................................................................................129
Regressions....................................................................................................................................................................129

Linear.......................................................................................................................................................................130
Linear Through Zero.................................................................................................................................................130
Mean Response Factor.............................................................................................................................................130
Quadratic.................................................................................................................................................................131
Power.......................................................................................................................................................................131
Wagner....................................................................................................................................................................131
Hill...........................................................................................................................................................................132

Calculating Final Concentrations...................................................................................................................................132
Linear.......................................................................................................................................................................132

MultiQuantTM MD 3.0.3 SoftwareReference Guide
5 / 169IVD-IDV-06-0904-C

Contents



Linear Through Zero and Mean Response Factor.....................................................................................................132
Quadratic.................................................................................................................................................................132
Power.......................................................................................................................................................................132
Wagner....................................................................................................................................................................133
Hill...........................................................................................................................................................................133

Appendix C Reports................................................................................................................................134
Create Reports...............................................................................................................................................................134
Create Custom Report Templates..................................................................................................................................135
Report Templates...........................................................................................................................................................137
Report Template Tags....................................................................................................................................................138

Appendix D Relative Noise and Signal-to-Noise Calculations.............................................................151
Note on Signal-to-Noise when Using the SignalFinder Integration
Algorithm.......................................................................................................................................................................155

Appendix E Software Icons....................................................................................................................156

Appendix F MultiQuantTM MD Software Access..................................................................................163
Security Settings............................................................................................................................................................166

Revision History......................................................................................................................................169

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C6 / 169

Contents



This document describes the functionality available in the MultiQuantTM MD software.

Access to the software is based on the role assigned to the user in the Analyst
®
 MD software. Make sure that each

user is assigned the correct access to the software.

Only the English version of the following Microsoft operating systems are supported:

• Windows 7 (32-bit and 64-bit) with SP1

• Windows 10

CAUTION: The format for numbers, currencies, dates, and time must be set to English
(United States). Setting the format to a different value may result in erroneous data.

MultiQuantTM MD software with audit trail and security features requires the full license and the Analyst
®
 MD

software be installed.

The controlled ways to output data from the software are exporting Results Tables, transferring to LIS, and reporting.
The other sources of output data such as copying and pasting from Results Tables are not controlled. Users should
not use those uncontrolled output methods for regulated purpose.

Note: MultiQuantTM MD software uses the Analyst
®
 MD software screen lock information. No additional setup

is required for the MultiQuantTM MD software.

Note:  The file and folder structure must be maintained to be able to view chromatograms. If data must be
moved, then move the whole project, maintaining the file structure.

Software Help
The software has tool tips and error messages that provide additional information about the software functionality.

• If a field is not available, then move the cursor over the field to display tool tips that explain why the functionality
is not available. Additional information includes how to enable the field or which security setting is required
to enable the field.

• Error messages include information on the security settings required to use the functionality.

MultiQuantTM MD 3.0.3 SoftwareReference Guide
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File Types
Table 1-1 Software File Types

DescriptionFile Type

MultiQuant software Results Table. Holds quantitation audit trail data.*.qsession

MultiQuant software quantitation method.*.qmethod

MultiQuant software audit map.*.qmap

External calibration file.*.mqcal

Column settings file.*.cset

Contact Us
SCIEX Support

• sciex.com/contact-us

• sciex.com/request-support

Customer Training

• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center

• SCIEXUniversity

For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Technical Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located throughout
the world. They can answer questions about the system or any technical issues that might arise. For more
information, visit the SCIEX website at sciex.com.
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Table 2-1 File Menu Options

DescriptionMenu Option

Quantitates a data set and then creates a Results Table. Select the data files to
process as well as the quantitation method to apply. Refer to  Results Table Dialogs
on page 43.

New Results Table

An empty quantitation Method Editor is created after the sample is selected. Typically,
the user creates a method as part of the New Results Table wizard. However, this
command is useful if the user wants to create a method but does not want to
immediately apply it to a collection of samples creating a Results Table.
• The navigation pane shows the subfolders, wiff files, and samples available in

the Data folder for the selected project.

• Expand individual folders to see any subfolders or wiff files. Expand the wiff file
to show the available samples.

New Quantitation Method

Opens a previously saved Results Table. After selecting the command, a standard
Open dialog opens. Refer to Results Tables on page 37.

Open Results Table

Opens a previously saved quantitation method. After selecting the command, a
standard Open dialog opens. Refer to Quantitation Method Editor on page 83.

Open Quantitation Method

Used to save the active Results Table or Quantitation Method Editor to a file. If the
Results Table or Quantitation Method Editor has never been saved, then the user is
prompted for the filename. Otherwise the previous version is overwritten.

Save

Used to save the active Results Table or Quantitation Method Editor to a new file.Save As

Contains submenu items for each recently used Results Table. Select one of the items
to open the corresponding file.

Recent Results Table

Contains submenu items for each recently used quantitation method. Select one of
the items to open the corresponding file.

Recent Quantitation
Methods

MultiQuantTM MD 3.0.3 SoftwareReference Guide
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Table 2-1 File Menu Options (continued)

DescriptionMenu Option

Creates a new quantitation method from a text file. Typically, the user creates a
method manually using the New Quantitation Method command (refer to Quantitation
Method Editor on page 83) or as part of the process of creating a new Results Table
(refer to Results Tables on page 37). This command is useful if the user wants to
create or modify a quantitation method. In this case, create a method manually and
then use the Quantitation Method as Text command.

Import

Contains commands for exporting quantitation methods as .qmethod or .txt files.
Refer to Export Submenu on page 11. The controlled ways to output data from the
software are exporting Results Tables, transferring to LIMS, and reporting. The other
sources of output data, such as copying and pasting from Results Tables, are not
controlled. Users should not use those uncontrolled output methods for regulated
purposes.

Export

A LIMS license file is required to activate the feature. Refer to Transfer to LIMS on
page 14.

Transfer to LIMS

Exporting Results Tables is one of the controlled methods for data output.Export and Save Results
Table

Creates a report in Microsoft Word using the Reporter software. Refer to Reports on
page 134. In the event of creating a custom template, the user is responsible for
validating the template. The user can edit the number format in the report template
editor. If the number format is not specified in the template, then the format in the
Results Table Column Setting are used in the report.

Create Report and Save
Results Table

Exits the program. The user is prompted to save any unsaved data.Exit

Import a Quantitation Method

1. Click File > Import > Quantitation Method from Text.

2. Select the text file.

3. Select a representative sample.

The Quantitation Method Editor opens.

4. Save the method in the *.qmethod format so that it can be subsequently used to quantitate a new data set.
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Export Submenu
The controlled ways to output data from the software are exporting Results Tables, transferring to LIMS, and
reporting. The other sources of output data such as copying and pasting from Results Tables are not controlled.
Users should not use those uncontrolled output methods for regulated purpose.

Table 2-2 Export Menu Options

DescriptionMenu Option

Creates a tab-delimited text file containing the information from the active Results
Table. Refer to Export Results Table-Metric on page 13.

Results Table-Metric

Exports the quantitation method to a new file. When a Results Table is created, a
copy of the quantitation method used to generate the table is saved internally with
the table. This is useful if the original quantitation method was deleted or modified
and the user wants to apply the original method to a new batch of samples creating
a Results Table.

Results Table's
Quantitation Method as
*.qmethod

Exports a copy of that method in a text format. When a Results Table is created, a
copy of the quantitation method used to generate the table is saved internally with
the table.

Results Table’s
Quantitation Method as
Text

These files contain a header row and a row for each component (analyte or internal
standard). There is a column for the component name, the mass range, each of the
integration parameters, and so on. Header rows must not be changed nor should
columns be added or deleted if the quantitation method is to be imported into
theMultiQuantTM MD software. If the header row for a column that specifies an
integration parameter is changed, or the column itself is deleted, the default value
as specified in the User Integration Defaults for that integration parameter will be
applied for all components. If the header row for any other column is changed or
deleted, the method will not be imported. The user should open the method and
confirm that all required changes are present in the imported quantitation method.
Refer to Table 2-1.

Quantitation Method as
Text

Export Results Tables

Note: The manufacturer assumes no responsibility or contingent liability including indirect or consequential
damages, after data has been exported from the software. The Results Table is exported in full precision, regardless
of the number format in the column setting.

MultiQuantTM MD 3.0.3 SoftwareReference Guide
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Figure 2-1 Export Dialog

DescriptionLabel

Format

Select to export in full precision. In this format the text file contains a header row
that uses the same column names as displayed in the Results Table. This is the
recommended format to export Results Tables.

MultiQuant

Select to export in the precision defined in the column setting. This format is the
same as exported by the Analyst

®
 MD software quantitation Results Tables. The

difference between this format and the previous format is that the column headers
use slightly different names in some cases (to match the Analyst

®
 MD software

format) and there are additional header rows for each analyte describing the
calibration.

Analyst

This format is similar to the Analyst
®
 MD software except that the column header

names match those used by the MacQuan quantitation package.
MacQuan

Columns

Select to export all possible fields, including those columns that are currently hidden
in the Results Table.

Export all columns
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DescriptionLabel

Select to export only those columns that are currently shown in the Results Table.
The user can also select which columns are visible using the Results Table
Column Settings command. Refer to Results Table Right-Click Menu on page
39.

Export only visible columns

Rows

Select to export all rows except those that are hidden due to specific filtering. Refer
to Software Icons on page 156. Rows that are hidden due to Sample Type filtering
or Component filtering are exported.

Export all rows except
those explicitly hidden

Select to export all rows (that is, all components for all samples).Export all rows

Select to export only those rows that are currently displayed in the Results Table.
Rows that are hidden due to Sample Type filtering or Component filtering are
not included.

Export only currently visible
rows

Export Results Table-Metric

Note: The manufacturer assumes no responsibility or contingent liability including indirect or consequential
damages, after data has been exported from the software. The Results Table is exported in full precision,
regardless of the number format in the column setting.

Used to create a tab-delimited text file containing the information from the active Results Table.

Figure 2-2 Export Metric Dialog
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DescriptionLabel

Select the field to export. Refer to Results Table Columns on page 54.Metric

If this option is selected, then only those components for which at least one
corresponding row is currently visible in the Results Table are exported to the file.
If this option is not selected, then information is exported for all components.

Visible components only

If this option is selected, then the resulting file has a column for each sample and
a row for each component (analyte or internal standard). If this option is not
selected, then there is a column for each component and a row for each sample.

Transpose (samples as
columns)

Transfer to LIMS
This command is only available when a Results Table is open. A LIMS license file is required to activate the feature.

The controlled ways to output data from the software are exporting Results Tables, transferring to LIMS, and
reporting. The other sources of output data such as copying and pasting from Results Tables are not controlled.
Users should not use those uncontrolled output methods for regulated purposes.

1. Click Help > Install License to activate a license.

Figure 2-3 LIMS Transfer Dialog

2. Type the server name in the Server field in the following format: http:\\server IP address;port number.

3. Select a template from the Template list.

4. Click Transfer.
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Table 3-1 Edit Menu Options

DescriptionMenu Option

Clears the current selection. This applies when the Components tab of the
Quantitation Method Editor has one or more selected rows.

Clear

When the Results Table is active, this command copies the selected portion of
the table to the clipboard. When the Peak Review or Calibration plot is active,
a picture of the plot is copied.

Copy

When the Results Table is active with an editable selected area, this command
pastes cells or columns from the clipboard.

Paste

When a Results Table or Statistics Table is active, this command copies all
data to the clipboard. In the case of a Results Table, only the currently visible
rows and columns are copied.

Copy Entire Table

When the Results Table is active with an editable selected area, this command
replicates the information in the first selected row to all subsequent selected rows.

Fill Down

Selects all rows in the currently active Results Table or Statistics Table. This
is useful if the user subsequently wants to apply a command, such as Copy, that
operates on the selected rows.

Select all Rows

Makes changes to the quantitation method associated with the currently active
Results Table. This is useful if the user wants to add or remove components. To
modify integration parameters only, use the Update Quantitation Method
for Group. Refer to Peak Review on page 62.

When the command is selected, the Quantitation Method Editor dialog opens.
Data is re-processed and the Results Table updates to show the data. Refer to
Quantitation Method Editor on page 83 and  Results Table Dialogs on page 43.

Reapplying the Quantitation Method overwrites all manually modified peaks
for the specified component and then clears check boxes in the Modified column
in the Results Table.

Modify Results Table
Method

MultiQuantTM MD 3.0.3 SoftwareReference Guide
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Table 3-1 Edit Menu Options (continued)

DescriptionMenu Option

Sets the default peak-finding parameters that are used when creating a quantitation
method. If there are more than a few components, set the default values based on
the chromatography so that they do not need to be adjusted individually for every
component. However, no one set of parameters is likely to be ideal for all components,
so it might be necessary to adjust some of the parameters individually for some of
the components. Refer to Integration Algorithm Parameters on page 122.

Project Integration
Defaults

Sets the default concentration units and regression parameters that are used when
creating a quantitation method. The user can also set these parameters when creating
the method itself. However if the same settings are used, then it is easier to set the
default values after using this command. Refer to Project Units & Calibration Defaults
on page 18.

Project Units & Calibration
Defaults

If selected, then data in the text file is encrypted during export. Set a password to
enable encryption. Refer to Project Secure Export Settings on page 18.

Project Secure Export
Settings

By default not selected. If selected, when a user makes a change to a chromatogram
in a Results Table and then saves the changes, a warning message opens,
indicating that a change has been made. The user has an option to continue saving
or to return to the Results Table. Refer to Modify Results Table Method on page
17.

Enable Project Modified
Peak Warning

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C16 / 169

Edit Menu



Table 3-1 Edit Menu Options (continued)

DescriptionMenu Option

When this feature is enabled, each time an extracted ion chromatogram (XIC) is
calculated for a particular sample and component, it is saved for future use as long
as the associated Results Table remains open.

For example, if the user creates a Results Table when this feature is enabled, then
the chromatograms in the Peak Review pane appear quickly because they have
been previously cached during the initial integration process to create the Results
Table and do not need to be recalculated from the information in the wiff file. If
the user opens a previously saved Results Table, then the individual chromatograms
must be calculated the first time they are shown in the Peak Review pane.
However, returning to a particular previous chromatogram will be faster.

There should be sufficient computer memory to cache all chromatograms. However,
for very large sample sets with a large number of analytes, this option should be
disabled to avoid out-of-memory messages.

Cache Chromatograms for
Faster Peak Review

When the Cache Chromatograms for Faster Peak Review command is
enabled, this command is used to calculate and then cache all chromatograms for
the active Results Table. For a large data set, this command might take some time
to execute. However, after it completes, all chromatograms are cached and the peak
review process is faster. The command can be stopped if required.

Perform this operation if many chromatograms will be reviewed. If the Cache
Chromatograms for Faster Peak Review option was initially enabled, this
operation does not need to be performed again after creating a Results Table
because the chromatograms are already cached. This command is useful after opening
a previously saved Results Table.

Cache all Chomatograms
Now

Modify Results Table Method
Makes changes to the quantitation method associated with the currently active Results Table. This is useful if the
user wants to add or remove components. To modify integration parameters only, use the Update Quantitation
Method for Group command. Refer to Update Quantitation Method for Group on page 70.

When the command is select, the Quantitation Method Editor dialog opens. Data is re-processed and the Results
Table updates to show the new data. Refer to Quantitation Method Editor on page 83.

Reapplying the Quantitation Method overwrites all manually modified peaks for the specified component and
then clears check boxes in the Modified column in the Results Table.

MultiQuantTM MD 3.0.3 SoftwareReference Guide
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Project Units & Calibration Defaults
Set the Concentration Units, Regression Parameter (Area or Height), Regression Type, and Weighting
Type. The various regression and weighting types are described in Regression Equations on page 128.

Figure 3-1 Units & Calibration Defaults

Project Secure Export Settings
Data in the text file is encrypted during export. Set a password to enable encryption. Refer to Figure 3-2.

Figure 3-2 Secure Export Settings Dialog
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Table 4-1 Process Menu Options

DescriptionMenu Option

Adds additional samples to a currently active Results Table. Refer to Select Samples
on page 43.

A progress bar is shown while the new samples are integrated and added to the
existing table. The user must have the Add samples to Results Table permission
enabled to perform this task.

Add Samples

Removes selected samples from a currently active Results Table. The user must
have the Remove samples from Results Table permission enabled to perform
this task.

Remove Selected Samples

Shows the rows that contain outliers.
Click Process > Show Only Outliers.

To show all the rows, click Process > Show Only Outliers again.

Show Only Outliers

Advances to the next outlier in the Results Table.
Click Process > Go to Next Outlier.

Go to Next Outlier

Saves a copy of the calibration equation for all analytes associated with the active
Results Table to an external file (*.mqcal). This allows the calibration from one
set of standard samples to be applied to other samples that are not part of the same
Results Table. Refer to Export Calibration on page 20.

Export Calibration and
Save Results Table

Applies a previously exported calibration to the active Results Table. An alternative
to using this command is to specify the external calibration file from the New
Results Table wizard as described in Define Integration on page 49. Refer to
Import External Calibration on page 20.

Import External Calibration

Removes a previously applied external calibration from an active Results Table.Remove External
Calibration

MultiQuantTM MD 3.0.3 SoftwareReference Guide
19 / 169IVD-IDV-06-0904-C

4Process Menu



Export Calibration
Saves a copy of the calibration equation for all analytes associated with the active Results Table to an external
file (*.mqcal). This allows the calibration from one set of standard samples to be applied to other samples that
are not part of the same Results Table.

The typical workflow is:

1. Create a new Results Table containing only the Standard.

2. Use the Peak Review pane to make sure that integration was successful.

3. Use the Export Calibration command to save a copy of the calibration.

4. Create a new Results Table containing samples of unknown concentration.

5. Apply the previously exported calibration to the new table by using the Import External Calibration
command or by specifying the calibration file.

6. Repeat steps 4 and 5 as required.

If the original Results Table (with the Standard samples) is changed, then any previously exported calibrations
are not automatically updated. The Results Table must be exported again.

Import External Calibration
If the same analyte names are used in the current Results Table as in the exported calibration, then the dialog
is completed automatically and the user can click OK. If the analytes in the current Results Table are assigned
to specific groups and if analytes in the exported calibration are assigned to groups with the same names, then
the dialog is completed automatically. If there are more than a few analytes, then use the same analyte names in
both cases or use consistent Group names.
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Figure 4-1 Assign External Calibrations Dialog

DescriptionLabel

Contains an entry for each analyte from the quantitation method for the
current Results Table.

Current Analyte

Contains a list of the names of all analytes available in the external calibration
file. For each of the current analytes, select the corresponding external analyte
from which the calibration is taken.

Analyte for Calibration
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Note: The audit map is added to the session when the Results Table is first created. It cannot be changed
after it has been added.

Table 5-1 Audit Trail Menu

DescriptionMenu Item

Opens the Audit Trail Viewer.Audit Trail Viewer

Selects, modifies, and activates Audit Maps.Audit Map Manager

Opens the current map of the active Results Table.View Session Audit Map

Audit Trail Viewer
The Audit Trail Viewer shows the complete history of a particular sample in the Results Table. Results Tables are
saved in the <drive>:\Analyst Data\Projects\<project name>\Results folder.

Note:
The Results Table should not be hidden when performing other actions. For example, as saving an Audit Trial.

To maximize another pane, such as the Peak Review pane, to view the data better, use the Toggles tab mode
button located on the toolbar.

Using the Audit Trail Viewer, users can:

• View the audit trail records for each Results Table.

• Perform a keyword search, which highlights every occurrence of the text.

• Filter the audited events in the software audit trail based on a set of specified criteria.

• Export the audit trail records to a txt file. Exported files can be edited.

• Print to a secured PDF.

View the Audit Trail Results in the Audit Trail Viewer

1. Open a Results Table.
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2. Click Audit Trail > Audit Trail Viewer.

3. To change projects, click the Projects list and then select another project.

4. To view other sessions, click the Sessions list and then select another session. Users can also select to view
all the sessions in the project at the same time.

Figure 5-1 Audit Trail Viewer

DescriptionLabel

Select a project from the list.Project

Select a session fileSession

A keyword search without filtering. Highlights every occurrence of the text.Find

Click to start the search.Go

Click to move to the next word.Next

Click to move to the previous word.Prev

Click to show only the events that match the selected criteria.Filter

Click to remove the filter.Remove Filter

Click to print the audit trailPrint

Click to export the audit trail.Export
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DescriptionLabel

When a session file is saved, a save event is created. The save event captures any
changes made from the previous save event as well as every value in the Results
Table.

Save Event

Details of the change event.Description

Shows the name of the session file.Session

Shows the reason for the change made to the Results Table.Reason

Shows the name of the user who made the change to the Results Table.Full User Name

Indicates if changes to the Results Table were accepted.E-Signature

Click to show or hide columns in the Results Table.Column Settings

Select to have both Results Tables scroll horizontally simultaneously.Synchronized

Shows the previous version of the selected session file.Previous version

Click to show the peak of the selected sample.Peak

Click to show the calibration curve of the selected sample.Cal Curve

Perform a Keyword Search
Users can perform a keyword search, which highlights every occurrence of the text.

1. Open a Results Table.

2. Click Audit Trail > Audit Trail Viewer.

3. In the Find field, type the word to search for and then click Go.

If matches are found, then the Find field turns green, the number of matches is shown, and the word is
highlighted in yellow. If matches are not found, then the Find field turns pink.

4. Use the Next and Prev buttons to move between the matches.

Filter Audited Events
Users can filter the audited events in the audit trail based on a set of specified criteria.

1. Open a Results Table.

2. Click Audit Trail > Audit Trail Viewer.

3. Click Filter.
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Figure 5-2 Filter Audit Trail Events Dialog

DescriptionItem

Name of the Results Table file. One Results Table file or all the Results Table files
for the active project can be filtered.

1

Description: Type the partial or full event type.

Sample Name: Type the partial or full sample name.

Full User Name: Type the partial or full name of the user.

E-Signature: Select Yes or No.

Reason: Type the partial or full reason.

2

is: Use to filter on a specific word or phrase.3

contains: Use to filter on a partial word or phrase.4

Date: Use to filter on events that occurred on a specific date and time.5

4. In the Filter Audit Trail Events dialog, use the lists to select filter criteria.
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Note: The Results Table field cannot be edited.

5. Click Clear to reset the filter criteria to No filter.

6. Click OK to filter the events.

Tip! To remove the filter, in the Audit Trail Viewer click Remove Filter.

Export the Audit Trail Viewer

1. Open a Results Table.

2. Click Export and then type a file name.

The file is exported as a tab-delimited text file.

Note: Only the saved events portion of the Audit Trail Viewer is exported.

Print the Audit Trail Viewer

1. Open a Results Table.

2. Click Print and then select a printer.

Users can print a secure PDF using pdfFactory.

Note: Only the saved events portion of the Audit Trail Viewer is printed.

Audit Trail Manager
The software groups quantitation audited events into audit trails. Audit trails are files that store records of the
audited events. Audit trails, combined with files such as wiff files, quantitation methods, and Results Table
files, constitute valid electronic records that can be used for compliance purposes.

The Audit Trail Manager software maintains all of the events as defined in the audit map. The software
captures the electronic signatures and reasons, including the user, date, and details of the changes. It also records
additional information, such as comments, according to the audit map.

Tip! A session file contains the Results Table, a copy of the quantitation method, a copy of the Audit Map
at time of creation, as well as the entire audit trail for the entire session.
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When the software creates or modifies a qsession or qmethod file, the event is captured in the Project Audit
Trail on the History tab in the Analyst

®
 MD software. The following events are captured:

• Quantitation method file has been created.

• Quantitation method file has been modified.

• Quantitation Results Table has been created.

• Quantitation Results Table has been modified.

If the E-signature or Reason Prompt is selected for creating or modifying the quantitation method file, then
the Audit Trail dialog generated by the Analyst

®
 MD software opens in the MultiQuantTM MD software.

Table 5-2 Audit Trails

Examples of Events RecordedAudit Trail

Changes to:
• Creation and modification of session files.

• Sample information.

• Peak integration parameters.

Quantitation Audit Trail (one per Results Table)

About Audit Maps
The MultiQuantTM MD software maintains all of the change history to the processing settings information associated
with the quantitation results. The software audits all of the events according to the active project audit map, and
it captures all of the electronic signatures and link, to respective records.

Create an Audit Map
The software installs several audit maps. View the audit maps to decide whether modifying one or more of them
would be easier than creating a completely new one. Creating or modifying audit maps are audited events in the
Analyst

®
 MD software project audit trail.

CAUTION: If two users are modifying the same audit map at the same time, then only the
changes made by the user who saved the file last are used.

The active audit map for the project determines which events are recorded in the audit trail for any Results
Tables that are created.

Note: After a Results Table is saved, the active audit map is saved with the Results Table and the audit
map cannot be modified.
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1. Click Audit Trail > Audit Map Manager.

Figure 5-3 Audit Map Manager

DescriptionLabel

Select a project from the list.Project

Click to edit the active audit map.Edit

Click to delete the selected audit map.Delete

2. In the Project list, select a project for which to create an audit map.

3. Select an audit map and then click Edit.
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Figure 5-4 Audit Map Editor

DescriptionLabel

Type a description of the audit map.Description

Click to select a check box.Check

Click to clear the check box.Uncheck

Click to add a predefined reason to the list.Add Predefined Reasons

4. Type a description of the audit map in the Description field if required.

5. In the Audit Map table, configure each event as follows:
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• To audit the event, select the check box in the Audited column.

Tip! To fill consecutive cells in a column with the check box value, press Ctrl or Shift, click the cells,
and then click Check.

• To have the operators type a custom reason or choose a predefined reason, select the check box in the
Reason Prompt column.

• To have the operators only select a predefined reason for the change when the event occurs, select the
check boxes in the Reason Prompt and the Predefined Reasons Only columns. In the Predefined
Reason _ columns, select up to ten reasons.

Tip! To add a predefined reason, click Add Predefined Reasons.

• To require electronic signatures for the event, select the check box in the E-Sig column.

6. Click Save As and then type a name in the Save Audit Map As dialog.

7. Click Save.

8. Click Close on the Audit Map Editor dialog.

9. Click Make Active.

When an audit map is applied, it becomes the active audit map. The audit configuration in the active audit
map determines which events are recorded in the audit trails from this point on.

Change the Audit Map

1. Click Audit Trail > Audit Map Manager.
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Figure 5-5 Audit Map Manager

DescriptionLabel

Select a project from the list.Project

Click to edit the active audit map.Edit

Click to delete the selected audit map.Delete

2. In the Project list, select a project for which to change the audit map.

3. Select another map and then click Make Active.

4. Click Close.

Edit the Audit Map
The following audit events are always recorded and are therefore not displayed in the Audit Map Editor: Print
Report, Export Results Table, and Transfer to LIMS.

1. Click Audit Trail > Audit Map Manager.
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Figure 5-6 Audit Map Manager

DescriptionLabel

Select a project from the list.Project

Click to edit the active audit map.Edit

Click to delete the selected audit map.Delete

2. Select an audit map and then click Edit.
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Figure 5-7 Audit Map Editor

DescriptionLabel

Type a description of the audit map.Description

Click to select a check box.Check

Click to clear the check box.Uncheck

Click to add a predefined reason to the list.Add Predefined Reasons

3. Type a description of the audit map in the Description field if required.

4. In the Audit Map table, configure each event as follows:
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• To audit the event, select the check box in the Audited column.

Tip! To fill consecutive cells in a column with the check box value, press Ctrl or Shift, click the cells,
and then click Check.

• To have the operators type a custom reason or choose a predefined reason, select the check box in the
Reason Prompt column.

• To have the operators only select a predefined reason for the change when the event occurs, select the
check boxes in the Reason Prompt and the Predefined Reasons Only columns. In the Predefined
Reason _ columns, select up to ten reasons.

Tip! To add a predefined reason, click Add Predefined Reasons.

• To require electronic signatures for the event, select the check box in the E-Sig column.

5. Click Save.

6. Click Make Active.

When an audit map is applied, it becomes the active audit map. The audit configuration in the active audit
map determines which events are recorded in the audit trails from this point on.

View the Embedded Audit Configuration
The audit configuration used for a Results Table is embedded in the Results Table file when the Results Table is
created. This configuration cannot be changed. The timestamp displayed next to the audit map name indicates
when the audit map used to embed the configuration was last saved.

1. Open a Results Table.

2. Click Audit Trail > View Session Audit Map.
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Figure 5-8 Session Audit Map
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With the exception of the About item, this menu contains the items listed in Table 6-1. These files are automatically
installed and they can also be found in the <drive>:\Program Files\AB SCIEX\MultiQuant 3\Help folder.

Documents or folders (or shortcuts to them) can be copied to this Help folder to have them automatically appear
in the menu.

Table 6-1 Help Menu

DescriptionMenu Item

Click to open the MultiQuantTM MD Activation dialog.Install License

Click to verify the files and installation.Verify Installation

Describes the features and functionality of the software.Software Reference
Guide

Provides information about the software as well as procedures for installing the software.Software Release Notes

Shows the version of the program, copyright, and other program information, along
with information about which license features are installed.

About
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A Results Table is the starting point for data review and export. Use the New Results Table wizard or
click File > New Results Table to create a Results Table. Refer to  Results Table Dialogs on page 43.

Note: The Sample Name and Sample ID columns cannot contain: \ / : * ? " < > |=.

The audit configuration used for a Results Table is embedded in the Results Table file when the Results
Table is created. This configuration cannot be changed. The timestamp shown next to the audit map name
indicates when the audit map used to embed the configuration was last saved.

Note: When moving data, move the whole project to maintain the file structure. If the file and folder structure
is not maintained, then a Results Table or chromatograms cannot be viewed.

There is a separate row for each component for each of the originally selected samples.

Figure 7-1 Example Results Table

• The IS, Component Name, and IS Name columns contain information about the analytes.

• The selected check box indicates the internal standard for the sample.

• Select which columns are shown in the Results Table using the Column Settings dialog. Refer to Column
Settings on page 40.
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• Change the width of the columns by dragging the line separating the two column headings. This information
is automatically saved and is applied when the user opens previously saved Results Tables.

• Change the order of the columns by clicking a column header and then dragging it to a new location. This
information is automatically saved and is applied when the user opens previously saved Results Tables.

• Users can limit the Results Table so that it only shows rows corresponding to particular analytes or internal
standards. Use the tool bar to limit the sample types that are shown. Refer to Components & Groups List on
page 38 and Sample Type Filter on page 42.

• Certain operations, such as synchronization with the Peak Review pane, are applied to the currently selected
row or rows. Select rows by clicking the area to the left of the first column.

Components & Groups List
When a Results Table is open, a list of the current components and groups is shown on the left side of the main
window. Use this list to change which components are visible in the Results Table as well as in any linked Peak
Review pane or Calibration plot.

Components are defined as a single transition or mass range. A Group is defined as the name of the group to
which the component belongs.

Figure 7-2 Components & Groups List

DescriptionLabelItem

Click to view all available analytes and internal standards in the
Results Table as well as the related Peak Review and
Calibration if shown.

All Components1

Click to view all internal standards and to hide all analytes. This
item is not present if no internal standards are defined.

All Internal Standards2

The name of each separate internal standard is included in the list.
Click one of these items to view that internal standard and to hide
all other components.

Specific Internal Standards3
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DescriptionLabelItem

Click to view all analytes and to hide all internal standards. This
item is not included if no internal standards are defined.

All Analytes4

The name of each separate analyte is included in the list. Click one
of these items to view that analyte and to hide all other
components.

Specific Analytes5

Click an individual item in the list to display only the components for that item. Press Shift or Ctrl to select
multiple items. This is useful to display, for example, two specific analytes only. Use the up and down arrow keys
when the list is active to move through the items.

Tip! Make the list wider or narrower by dragging the right edge of the pane to the left or right.

The actual order of the rows in the Results Table is not affected by filtering. The Results Table is preset to be
ordered first by sample and then by component, in the order indicated in the quantitation method. However, the
table can also be sorted in a specific order as described in Software Icons on page 156.

Results Table Right-Click Menu
Right-click in the Results Table to access a context menu. The following commands are available.

Table 7-1 Results Table Right-Click Menu Options

DescriptionMenu Option

Use this command to edit the Results Table columns. The changes are only applied
to the current Results Table unless it is saved as project default.

Column Settings

Adds a new editable column to the table. Populate the column by typing directly
into the cells or by pasting content. Any text can be entered such as comments or
the results of custom calculations.

Add Custom Column

Renames an existing custom column. Before using this command, click the custom
header to select the custom column.

Rename Custom Column

Use to delete an existing custom column. Before using this command, click the
column header to select the custom column.

Remove Custom Column

Provides a shortcut for setting the Actual Concentration field for all analytes
for samples of type Standard if there is more than one analyte and all analytes
are present in these samples at the same concentration. Refer to Apply Current
Analyte's Actual Concentrations to All on page 40.

Apply Current Analyte's
Actual Concentrations to
All
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Table 7-1 Results Table Right-Click Menu Options (continued)

DescriptionMenu Option

Similar to the Apply Current Analyte's Actual Concentrations to All
except that it applies to internal standards rather than analytes.

Apply Current IS's Actual
Concentrations to All

Use this command to perform absolute quantitation to determine whether a particular
Standard sample should be used in the calculation of the calibration curve for a
given analyte.

The first two items are used to select or clear the Used field for the currently selected
rows in the Results Table. The third and fourth items are similar except that the
operation applies to all analytes for any samples corresponding to a selected row.

Set 'Used'

Use this command to clear the peak integration for the currently selected rows.Set Peaks to 'Not Found'
for Selected Rows

Apply Current Analyte's Actual Concentrations to
All

1. Use the Components & Groups List on page 38 to limit the table to only displaying one particular analyte.

2. Optionally use the Sample Type Filter to only view Standard samples. Refer to Sample Type Filter on
page 42.

3. Specify the actual concentrations for the analyte, either by typing directly into the cells or by selecting the
column and then selecting Paste if the concentrations are available elsewhere in a text format.

4. Click Apply Current Analyte’s Actual Concentrations to All.

5. Return to viewing all components and all sample types as required.

Column Settings
If column names are truncated, then move the cursor over the field to display the column name in a tool tip.

For numerical fields, use the format 0.00 for non-scientific notations and use the format 0.00e0 for scientific
notations. Change the decimal points to indicate the precision of the numbers that are shown. Only a period (.)
can be used as a decimal separator. Digit grouping is not supported.
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Figure 7-3 Column Settings Dialog

DescriptionField

Click to select a column settings file previously saved using Export. The dialog
fields are updated to use the information from the selected file.

Import

Click to save the current dialog settings to a file. This enables the user to switch
between different column settings.

Export

Shows the name of the columns in alphabetical order. Refer to Results Table Columns
on page 54.

Column Name

Select to make the column visible. Otherwise, the column is hidden.Visible

For numerical fields, use the format 0.00 for non-scientific notations and use the
format 0.00e0 for scientific notations. For displayed precision, change the decimal
points.

Number Format

The rows that show LIMS Supported selected are predefined by the LIMS and the
column selections cannot be changed.

LIMS Supported

Select to use the column settings in future Results Tables.Save as project default
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Sample Type Filter
Table 7-2 Sample Type Filter Descriptions

DescriptionFilter Type

Shows all sample types.All Sample Types

Shows only Unknown samples, which are normal samples of unknown concentration.
When Standard samples are used, their concentration is back-calculated from the
calibration curve and reported in the Results Table as the Calculated Concentration.
Refer to Regression Equations on page 128.

Unknowns

Shows only samples of known concentration. These samples are used for the creation
of the calibration curve.

Standards

Shows only Quality Control samples. These samples of known concentration are
used to check the accuracy of the calibration curve but do not influence its actual
construction.

Quality Controls

Shows both Standard and Quality Control samples.Standards & QCs

Shows Unknown, Standard, and Quality Control samples.Unknowns, Standards &
QCs

Shows only Blank samples. These are generally samples that contain the internal
standard compounds, if used, but no analytes, and that have been through the
normal sample preparation procedure. These samples are not used in the construction
of the calibration curve. To include them, select the Standard sample type and then
set the Actual Concentration at 0.

Blanks

Shows only Double Blank samples. These are samples with neither internal standards
nor analytes.

Double Blanks

Shows only Solvent samples. These are double blanks that have not been through
the normal sample work-up procedure.

Solvents

Shows all of the blank sample types: Blank, Double Blank, and Solvent samples.Blanks, Double Blanks &
Solvents

View Hidden Rows
In the Results Table, for any given component, rows are only seen for those samples for which the corresponding
MRM transition is available. The unused rows, components with transitions not available for a given sample, are
present in the table but they are hidden by default.

1. Show the Peak Comment column in the Results Table, if it is not already visible.
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2. Sort the table using this column.

3. Select the (now adjacent) rows with the Not Present comment.

4. Click the Hide selected rows(s) icon. Refer to Software Icons on page 156.

Results Table Dialogs

Select Samples
Select the samples from the wiff files to be processed.

Figure 7-4 Create Results Table - Select Samples Page

• The Available pane shows the subfolders, wiff files, and samples available in the Data folder for the selected
folder.

• Expand individual folders to see any subfolders or wiff files. If the wiff file is expanded, it opens to show the
available samples.
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• Use the arrows to add or remove samples.

• Select samples by double-clicking an individual sample, by selecting a sample or data file and then clicking
the => button, or by dragging a sample or data file from the left pane to the right one. Press Shift or Ctrl to
select multiple files or samples before moving them.

Select Method
Select the quantitation method. If an existing method is selected but not edited, then a progress bar is shown
while the selected samples are processed. At the end of this process, a Results Table is created.

Figure 7-5 Create Results Table - Select Method Page
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DescriptionLabel

Click Open to select an existing quantitation method.Choose Existing Method

Select this command to edit an existing method. The subsequent pages of the wizard
are populated with information from the existing method that can be modified as
required.

Edit Method

Click New to create a quantitation method. The algorithm in parentheses is the
algorithm selected in the Integration Defaults dialog.

Create New Method

Select Representative Sample
The Select Representative Sample page shows the selected representative sample for which chromatograms
are shown when visually setting the peak-finding and integration parameters. This sample must contain all of the
compounds that will be included in the quantitation method.

If sample types and analyte concentrations were selected using the Analyst
®
 MD software Batch Editor before the

samples were acquired, then this information is shown as additional columns.

The software selects a sample by default. If the selected sample is not appropriate, then select another representative
sample. If the SignalFinderTM algorithm is selected, to avoid generating an incorrect integration model, no
representative sample is recommended by the software if the TIC level is above 1.0e6 in all samples. Users can
select a representative sample manually in this scenario.
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Figure 7-6 Create Results Table - Select Representative Sample Page

Define Components
The Define Components page contains a row for each analyte or internal standard. Select the names of the
analytes and internal standards, if used. Refer to Define Components Right-Click Menu on page 48.
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Figure 7-7 Create Results Table - Define Components Page

DescriptionLabel

Select an experiment to process from the list. For multi-period or multi-experiment data, select
each of the experiments that must be processed and then fill in the table with the components
for the corresponding experiment.

Experiment

Contains the current row number.Row

Indicates whether the component defined for the row is an analyte (not selected) or an internal
standard (selected).

IS

Contains the name of the component. For MRM experiments, the name is automatically completed
using the Q1/Q3 transition masses. For a more specific name, type a name in the field.

Name
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DescriptionLabel

Contains the name of the group to which the component for the row belongs. If analytes or internal
standards that are related to one another are placed in the same group, then they can be reviewed
and manipulated together more easily. This is true for entities that have the same retention time
as one another, for example different MRM transitions for the same compound.

Type the group names or populate them automatically. Refer to Define Components Right-Click
Menu on page 48.

Group

Contains the name of the optional internal standard that should be used for the analyte defined
for the row. This field is not applicable to internal standards themselves.

IS Name

For MRM experiments, this column is entitled Q1/Q3 and contains the mass pair for the component
defined for the row. Select the required transition from the list that shows all of the available
transitions for the experiment. Usually, the column is automatically initialized with the available
transitions.

For profile (scan) experiments this column is entitled Start - Stop and contains the mass range
used to calculate an XIC (extracted ion chromatogram) for the component defined for the row.
Type the mass range with a hyphen separating the two masses. For example, 200-201 or 200-1.
For the latter option, the mass range is 199.5-200.5.

Mass Info

Define Components Right-Click Menu

Right-click in the Define Components page to access a context menu. The following commands are available.

Table 7-3 Define Components Right-Click Menu Options

DescriptionMenu Option

Clears the contents of any selected rows or columns. Rows are selected by clicking
or dragging in the area before the row numbers.

Clear

Copies any selected rows or columns to the clipboard.Copy

Pastes the contents of the clipboard.Paste

Selects the component whose Name matches the text. The exact text is not required
to find a match. This is useful to select a specific component if there are many
components.

If no row is initially selected in the spreadsheet, the search starts from the first row.
Otherwise, the search starts from the row following the selected row and wraps
around to the beginning. This is useful if there is more than one component whose
Name contains the text. If the first search does not find the component, search
again, leaving the first component selected, to locate another match in the table.

Find Component by Name

Inserts a single blank row immediately above the currently selected row.Insert Row Above
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Table 7-3 Define Components Right-Click Menu Options (continued)

DescriptionMenu Option

Removes the currently selected rows from the table.Delete Selected Rows

Sums chromatograms for multiple MRM transitions or full-scan mass ranges. After
the command is selected, additional mass columns are added to the Components
table. Any masses selected for a given row are used in the construction of the summed
XIC for the corresponding analyte or internal standard. It is recommended that this
feature is always selected.

Sum Multiple Ions

Refer to Groups Submenu on page 84.Groups

Refer to Internal Standards Submenu on page 86.Internal Standards

Define Integration
Select the expected retention time and other peak finding parameters for each of the components.

The list on the left shows an entry for each component defined on the previous page of the wizard. Click a specific
row to view the corresponding chromatogram and the current integration for the representative sample. Scroll
through the list by using the up and down arrow keys or by using the scroll wheel. In general, it is recommended
that all components be reviewed for correctness of integration. However, if there are many components, then use
the Highlight Components with Uncertain RT command to limit the number to be reviewed.

Note: If there are more than a few components, then make sure that the peak-finding parameters are set to
reasonable defaults before running the wizard to avoid adjusting the parameters for each component.

Right-click in the page to view the available commands. Refer to Define Integration Right-Click Menu on page
51.

In the Regression group, change the calibration options for all or selected components after the Results Table
is created. Set the default concentration units and regression parameters so that they do not need to be adjusted
each time.

Tip! Zoom in on the graph by dragging the x or y axis regions. Return to the preset view by using the context
menu (Home Graph Axes) or by double-clicking in the axis region.
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Figure 7-8 Create Results Table - Define Integration Page

DescriptionLabel

Adjusts the peak-finding parameters, if necessary, for a given component. When creating
the new Results Table, the specified parameters for a given component are applied to
that component for all samples when the data is integrated. Refer to Integration
Algorithm Parameters on page 122.

Apply

Initially set as the retention time of the point with the largest intensity for the
chromatogram. Usually this is the required peak. However, if isomers are present, then
this value might need to be adjusted. To adjust the value, type a new value in the
Expected RT field and then click Apply. Alternatively, click in the graph and then
drag across the peak of interest. Be careful not to accidentally drag the cursor in the
graph and adjust the expected retention time.

Expected RT

Select Area or Height.Parameter

The various fit types are described in Regression Equations on page 128.Fit
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DescriptionLabel

The various weighting types are described in Weighting Factors on page 129.Weighting

Type the concentration units used for the analytes and any internal standards. If relative
quantitation is performed, then leave this field blank. The wizard assumes that the same
units are used for all components. If this is not the case, then use the Quantitation
Method Editor.

Concentration Units

Users can type a concentration unit for individual components. To apply the same unit
to all the components, select this check box. The information should be consistent with
the Concentration Units.

Apply units to all
Analytes

Define Integration Right-Click Menu

Right-click in the Define Integration page to access a context menu. The following commands are available.

Table 7-4 Define Integration Right-Click Menu Options

DescriptionMenu Option

Similar to the command available from the Define Components page, except
the difference is that instead of selecting rows of the Components spreadsheet,
individual items in the components list are selected.

Find Component by Name

Used to highlight those components for which the default expected retention time
(taken as the RT of the peak with the largest intensity for each chromatogram) is
incorrect. If there are only a few components, then review each one individually and
do not use this command. However, if there are many components, then use this
command to visually check only those for which there is more than one significant
peak present in the chromatogram. Refer to Highlight Components Dialog on page
88.

Highlight Components with
Uncertain RT

Returns the zoomed graph to its home view where all data is visible.Home Graph Axes
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Table 7-4 Define Integration Right-Click Menu Options (continued)

DescriptionMenu Option

Use this command to overlay chromatograms if various components have been
assigned to groups, and if the components assigned to any given group are expected
to have the same retention time. For example, if they represent different MRM
transitions of the same actual compound.

When selected, the chromatogram for the current component, whose integration
parameters are being defined, is drawn using a solid blue trace and its integrated
peak area is shown. The chromatograms, and not the integrated peak area, for the
other components in the same group are overlaid using a dashed line style.

Overlay Other Components
for Group

Used to reset the expected retention times for a previously created quantitation
method. If an existing quantitation method is opened and Set New Typical
Sample is selected, then the chromatograms shown correspond to the new sample
but the expected retention times are left unchanged.

For each component, the expected retention time is updated to correspond to the
retention time of the peak with the largest intensity within a window of the specified
width centered at the original expected retention time.

Refer to Update Retention Time Dialog on page 88.

Update Retention Times

Outlier Settings
Users can flag the outliers of the accuracy for the Standards, QCs, Ion Ratio, and Calculated
Concentration. The following commands are available.
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Figure 7-9 Outlier Settings Dialog

DescriptionLabel

Edits the accuracy tolerance of the Standard samples.Accuracy for Standards

Edits the accuracy tolerance for the Standard samples with a value that is consistent
with the laboratory standard operating procedures.

Max. Accuracy Tolerance
for Stds except LLOQ%

Edits the accuracy tolerance for the lowest concentration Standard if the laboratory
standard operating procedure indicates a different tolerance for this Standard.

Max. Accuracy Tolerance
for LLOQ (lowest Std)%

Edits the accuracy tolerance of the Quality Control samples.Accuracy for QCs

Edits the accuracy tolerance for the Quality Control samples with a value that
is consistent with the laboratory standard operating procedures.

Max. Accuracy Tolerance
for QC%

Only available if the components are assigned to groups. Select to use the ion ratio
of the peak area or peak height. Peak area or peak height is set when selecting the
regression parameter during quantitation method development.

Ion Ratio
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DescriptionLabel

When using Standard samples of known concentration, this is the back-calculated
concentration from the calibration curve. Regression equations describe how the
regression is performed for the various regression types and weighting.

Calculated Concentration

The analytes or internal standards for all samples.Component

The selected internal standard. Only available if the Ion Ratio check box is selected.IS

Components that have the same retention time (that is, different transitions for the
same compound) can be grouped. Only available if the Ion Ratio check box is
selected.

Group

Use the default setting or edit this setting according to laboratory standard operating
procedures. Only available if the Ion Ratio check box is selected.

Ion Ratio Tolerance (%)

Type the lower limit of the acceptable concentration range. Any sample with the
Calculated Concentration lower than this value is flagged as a concentration
outlier.

Lower Limit of Calculated
Concentration

Type the upper limit of the acceptable concentration range. Any sample with the
Calculated Concentration higher than this value is flagged as a concentration
outlier.

Upper Limit of Calculated
Concentration

Right-click in the Outlier Settings page to access a context menu.

Table 7-5 Outlier Settings Right-Click Menu Options

DescriptionLabel

Applies the lower limit of the calculated concentration
to all of the analytes, if all of the analytes have the same
criteria.

Apply to all analytes the Lower Limit of Calc.
Concentration

Applies the upper limit of the calculated concentration
to all of the analytes, if all of the analytes have the same
criteria.

Apply to all analytes the Upper Limit of Calc.
Concentration

Results Table Columns

Note: Some critical columns of the sample information such as Sample Name, Sample ID, and so on should
not be hidden when users customize the Results Table column settings.
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For numerical fields, use the format 0.00 for non-scientific notations and use the format 0.00e0 for scientific
notations. Change the decimal points to indicate the precision of the numbers that are shown. Only a period (.)
can be used as a decimal separator. Digit grouping is not supported.

Table 7-6 Results Table Columns

DescriptionLabel

When using Standard samples of known concentration for Standard samples
and Quality Control samples, this is defined as:

100% * (Calculated Concentration) / (Actual Concentration)

For other sample types, the value is N/A.

Accuracy

The name of the acquisition method used to acquire the sample.Acq. Method Name

The date and time at which the wiff sample was acquired.Acquisition Date & Time

For Standard samples and Quality Control samples, this is the expected known
concentration.

Actual Concentration

The detected peak area. If no peak was detected the value is N/A.Area

The detected peak area divided by the height. If no peak was detected the value is
N/A.

Area / Height

For analytes using an internal standard, this is the ratio of the Area to the IS Area.
For internal standards or for analytes without an internal standard, the value is N/
A.

Area Ratio

The distance from the center line of the peak to the back slope divided by the distance
from the center line of the peak to the front slope, with all measurements made at
10% of the maximum peak height.

Asymmetry Factor

The absolute value of the height difference of the baseline (at the start of the peak
and the end of the peak) to the actual peak height. Values greater than approximately
0.1 indicate that the baseline might not have integrated correctly and that the peak
should be reviewed.

Baseline Delta / Height

When using Standard samples of known concentration, this is the back-calculated
concentration from the calibration curve. Refer to Regression Equations on page 128
for information on how the regression is performed for the various regression types
and weighting.

Calculated Concentration

An arbitrary comment that applies for the analyte or internal standard for all samples.Component Comment

The group name (if any) associated with the analyte or internal standard.Component Group Name

The index of the analyte or internal standard in the original quantitation method. It
can be useful to sort the table based on this field.

Component Index

MultiQuantTM MD 3.0.3 SoftwareReference Guide
55 / 169IVD-IDV-06-0904-C

Results Tables



Table 7-6 Results Table Columns (continued)

DescriptionLabel

The name of the analyte or internal standard.Component Name

The concentration units.Conc. Units

For analytes using an internal standard, this is the ratio of the Actual
Concentration to the IS Actual Concentration. For internal standards or for
analytes without an internal standard, the value is N/A.

Concentration Ratio

The detected peak area. If no peak was detected, then the value is N/A.Corrected Area

The detected peak area divided by the height. If no peak was detected, then the
value is N/A.

Corrected Area / Height

The detected peak height. If no peak was detected, then the value is N/A.Corrected Height

The factor by which the sample has been diluted. This factor is used in the calculation
of the calibration curve. Refer to Regression Equations on page 128.

Dilution Factor

The ending retention time of the detected peak, in minutes.End Time

The time in minutes along the back side of the peak where the intensity is at 10%
of the peak height.

End Time at 10%

The time in minutes along the back side of the peak where the intensity is at 5% of
the peak height.

End Time at 5%

The expected ion ratio for all sample types.Expected Ion Ratio

The original expected retention time from the quantitation method, in minutes.Expected RT

The detected peak height. If no peak was detected, then the value is N/A.Height

For analytes using an internal standard, this is the ratio of the Height to the IS
Height. For internal standards, or for analytes without an internal standard, the
value is N/A.

Height Ratio

This is the index of the row in the original, unsorted order. If the table is sorted based
on another column, it can be returned to the original order by sorting on this column.

Index

The volume of sample injected by the autosampler, in mL.Injection Volume
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Table 7-6 Results Table Columns (continued)

DescriptionLabel

• A value of Baseline indicates that a stand-alone peak was integrated in the
usual way.

• A value of Valley indicates that there were two adjacent peaks and that the
signal did not return to the baseline value between them.

• A value of Manual indicates that the peak was manually integrated.

• A value of N/A indicates that no peak was detected.

Integration Type

• Ion Ratios are determined when at least two MRM transitions from a single
analyte have been collected into a group.

• The first component in a subgroup will be used as Quantifier ions. The
remainder of the components in the subgroup will be used as Qualifier ions.

• Ion Ratio = (Peak Area or Height of Qualifier) / (Peak Area or Height of Quantifier)

• Subgroups

• All analytes of a group constitute an Analyte subgroup.

• All internal standards of a group constitute an IS subgroup.

• If a component is not a member of a group, then the Ion Ratio is N/A.

• If the peak is not found, then the Ion Ratio is N/A.

• Applied to all components in both Analyte and IS subgroups, for the
Quantifier, the Qualifier is itself.

• If the integration changes for either the Quantifier or the Qualifier peaks,
then the Ion Ratio is calculated again.

• Can be calculated for either peak area or peak height. If the Area is used in the
regression part of a .qmethod for the first component (Component Index is 1) in
the Results Table, the peak area is used for the calculation of the Ion Ratio
for the entire Results Table. If the Height is used in the regression of the
first component, then the peak height is used for the calculation.

Ion Ratio

A selected check box indicates that the component for the row is an internal standard,
not an analyte.

IS

Actual concentration for the internal standard associated with the current analyte,
or N/A for internal standards or for analytes without an internal standard.

IS Actual Concentration

Area for the internal standard associated with the current analyte, or N/A for internal
standards or for analytes without an internal standard.

IS Area
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Table 7-6 Results Table Columns (continued)

DescriptionLabel

The ratio of the Area to the Height for the internal standard associated with the
current analyte, or N/A for internal standards, or for analytes without an internal
standard.

IS Area / Height

Baseline Delta / Height for the internal standard associated with the current
analyte, or N/A for internal standards or for analytes without an internal standard.

IS Baseline Delta / Height

An arbitrary comment for the internal standard associated with the current analyte,
or N/A for internal standards, or for analytes without an internal standard.

IS Comment

Corrected area for the internal standard associated with the current analyte, or N/A
for internal standards, or for analytes without an internal standard.

IS Corrected Area

Corrected Area / Corrected Height for the internal standard associated with
the current analyte, or N/A for internal standards, or for analytes without an internal
standard.

IS Corrected Area / Height

Corrected Height for the internal standard associated with the current analyte,
or N/A for internal standards or for analytes without an internal standard.

IS Corrected Height

End Time for the internal standard associated with the current analyte, or N/A for
internal standards or for analytes without an internal standard.

IS End Time

Expected RT for the internal standard associated with the current analyte, or N/
A for internal standards or for analytes without an internal standard.

IS Expected RT

Height for the internal standard associated with the current analyte, or N/A for
internal standards or for analytes without an internal standard.

IS Height

Integration Type for the internal standard associated with the current analyte,
or N/A for internal standards or for analytes without an internal standard.

IS Integration Type

Mass Info for the internal standard associated with the current analyte, or N/A for
internal standards or for analytes without an internal standard.

IS Mass Info

Component Name for the internal standard associated with the current analyte,
or N/A for internal standards or for analytes without an internal standard.

IS Name

Peak Comment for the internal standard associated with the current analyte, or
N/A for internal standards or for analytes without an internal standard.

IS Peak Comment

Quality for the internal standard associated with the current analyte, or N/A for
internal standards, or for analytes without an internal standard.

IS Quality

Quality metric for the internal standard associated with the current analyte, or N/A
for internal standards, or for analytes without an internal standard.

IS Region Height
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Table 7-6 Results Table Columns (continued)

DescriptionLabel

Retention Time for the internal standard associated with the current analyte, or
N/A for internal standards or for analytes without an internal standard.

IS Retention Time

Signal / Noise for the internal standard associated with the current analyte, or
N/A for internal standards or for analytes without an internal standard.

IS Signal / Noise

Start Time for the internal standard associated with the current analyte, or N/A
for internal standards or for analytes without an internal standard.

IS Start Time

Total Width for the internal standard associated with the current analyte, or N/A
for internal standards or for analytes without an internal standard.

IS Total Width

Width at 50% for the internal standard associated with the current analyte, or N/A
for internal standards or for analytes without an internal standard.

IS Width at 50%

Mass information associated with the component. For MRM experiments this is Q1/
Q3 and for profile (full scan) experiments it is Start - Stop.

Mass Info

A check mark indicates that the peak-finding parameters have been modified, using
the Peak Review pane, from their original values indicated in the quantitation
method.

Modified

The name of the instrument operator who acquired the sample.Operator Name

The name of the wiff file.Original Filename

When the outlier criteria have been set in the quantitation method, this column
indicates which criterion was found to be outside the predetermined limits for the
component.

The Outlier Reasons column is only linked to the Outlier Settings in the
quantitation method and it is a preset column in the Results Table.

The reason the outlier is flagged:

• Accuracy

• Concentration

• Ion Ratio
If there is a peak for the quantifier but not the qualifier, then the ion ratio will
be flagged for both components. If there is a peak for the qualifier but not the
quantifier, then the ion ratio will be flagged for both components. If neither have
peaks, then there is no flag for either component.

• Cannot calculate the Expected Ion Ratio.

Outlier Reasons

An arbitrary comment for the row.Peak Comment
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Table 7-6 Results Table Columns (continued)

DescriptionLabel

Autosampler plate number, as originally specified in the Batch Editor used to
acquire the data.

Plate Number

The number of scans from the start to the stop of the peak.Points Across Baseline

The number of scans across the peak at approximately 50% of the height.Points Across Half Height

This metric attempts to indicate the quality of the integrated peak.

• Values near zero indicate that the peak has integrated poorly (or that no actual
peak is present).

• Values near 1.0 indicate that the peak integrated well and does not need to be
reviewed.

Quality

Autosampler rack number, as originally specified in Batch Editor used to acquire
data.

Rack Number

The peak height of the largest peak in the vicinity of the actual detected peak. This
is useful in conjunction with the Quality field. Peaks with a low quality that also
have a reasonable Region Height need to be reviewed. If the Region Height
is small, then there is no significant peak present.

Region Height

For analytes that are using an internal standard, this is the ratio of the Retention
Time to the IS Retention Time. For internal standards, or for analytes without
an internal standard, the value is N/A.

Relative RT

The actual retention time of the detected peak, in minutes.Retention Time

An arbitrary comment for the sample.Sample Comment

An arbitrary identifier for the sample. It is initialized from the value originally specified
in the Batch Editor used to acquire the data.

Sample ID

The index of the current sample.Sample Index

An arbitrary name for the sample. It is initialized from the value originally specified
in the Batch Editor used to acquire the data.

Sample Name

The type for the sample. Refer to Sample Type Filter on page 42.Sample Type
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Table 7-6 Results Table Columns (continued)

DescriptionLabel

An estimate of the ratio of the peak height for the detected peak to the noise present
in the chromatogram.

When using the SignalFinder integration algorithm, noise is estimated using the
calculated relative noise and the baseline at the peak apex position. The MQ4
integration algorithm uses a similar approach, except that the baseline is estimated
using the entire chromatogram.

Refer to Relative Noise and Signal-to-Noise Calculations on page 151.

Signal / Noise

Indicates the drift of the baseline.Slope of Baseline

The starting retention time of the detected peak, in minutes.Start Time

The time in minutes along the front side of the peak where the intensity is at 10%
of the peak height.

Start Time at 10%

The time in minutes along the front side of the peak where the intensity is at 5% of
the peak height.

Start Time at 5%

The distance from the front slope of the peak to the back slope, divided by twice the
distance from the center line of the peak to the front slope, with all measurements
made at 5% of the maximum peak height.

Tailing Factor

The chromatographic peak width, in minutes, at the baseline.Total Width

For Standard samples, a check mark indicates that the corresponding analyte is
currently used for construction of the calibration curve. For Quality Control
samples, a check mark indicates that the analyte is used for the calculation of the
QC statistics. For other sample types, this field is for informational purposes only.

Used

Autosampler vial number as originally specified in Batch Editor used to acquire
data.

Vial Number

The width of the peak measured at 10% of the peak height.Width at 10%

The width of the peak measured at 5% of the peak height.Width at 5%

The chromatographic peak width, in minutes, of the detected peak measured at half
of its apex intensity.

Width at 50%
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Use the Peak Review pane to visually inspect the raw chromatograms so that the quality of the peak-finding
process can be determined. When a Results Table is active, click the Show Peak Review icon in the Results
Table tool bar to open the Peak Review pane. Reviewers should review the quantitative data according to the
criteria of peak integration and data acceptance in their own standard operating procedures (SOPs).

The grouping of numbers is not supported. Users should not group numbers in any text box (for example, integration
parameters) and grid (for example, Results Tables).

Enhanced Peak Review indicates the Ion Ratio acceptance on an overlaid chromatogram. Users can also
magnify a single chromatogram.

Figure 8-1 Peak Review Pane

Use the Peak Review pane to correct chromatograms that did not integrate properly by either adjusting the
peak-finding parameters or by manually selecting the starting and ending points for integration. After a
chromatogram is integrated, the Results Table is automatically updated with the new peak area and other
parameters.

Quantitation methods include the criteria used to quantitate the peaks selected for integration. Reviewers should
review the quantitative data according to the criteria of peak integration and data acceptance in their own SOPs.

Manual Integration
After a peak in a particular chromatogram is manually integrated, select this check box to indicate that the
chromatogram is manually integrated. When in this state, if the user clears the check box, then manual integration
for the peak is canceled and the peak is automatically re-integrated using the method parameters.

The difference between this check box and the Enable Manual Integration Mode button is that this check
box reflects the status of the current peak, whereas the button specifies the behavior when dragging a
chromatogram.
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Note: After manual integration mode is enabled, it remains enabled for all panes until it is cleared.

Apply
If the user has adjusted any of the peak-finding parameters, then the Apply button is enabled. Click the button
to apply the modified peak-finding parameters to the active chromatogram.

Except when in manual integration mode, dragging across a particular peak in a chromatogram is equivalent to
adjusting the Expected RT parameter and then clicking Apply.

Note: If the user modifies the peak-finding parameters and then activates a different chromatogram without
clicking Apply, then the parameters are not applied and the changes are lost.

Tips for Reviewing Peaks
• Sort the Results Table on a particular column and review only those chromatograms that sort to the top or

bottom of the table.

• The Peak Review pane is always synchronized with its corresponding Results Table and shows the
chromatograms for the same peaks, in the same order, as in the Results Table. Any changes (such as sorting
rows, filtering sample types, or selecting any components) that are made to the Results Table are automatically
reflected in the Peak Review pane.

• Select the number of chromatograms to view at one time.

• Use the scroll bar at the right of the pane to scroll through the available chromatograms. When the Peak
Review pane is active, use the up and down arrow keys on the keyboard or the scroll wheel to move through
the chromatograms.

• At any one time, one particular chromatogram is considered to be active and is indicated by the title in bold.
Make a particular chromatogram active by clicking anywhere within it.

• When a chromatogram becomes active, the integration parameters shown at the left of the pane are updated
to reflect the newly active chromatogram. If the user adjusts the peak integration parameters and then clicks
Apply, this affects the currently active chromatogram.

• Select a row in the Results Table by clicking in the gray region to the left of the first column to show the
corresponding peak in the Peak Review pane. If the user scrolls to a particular chromatogram in the Peak
Review pane, the Results Table highlights the corresponding row and then scrolls it into view.

• If the user drags across a particular peak in a chromatogram, then the Expected RT integration parameter
is updated with the actual retention time of the peak. The new retention time is then automatically applied
and the peak is integrated again, updating the Results Table.
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• If the user is reviewing peaks in manual integration mode, then dragging across the peak will manually integrate
the selected peak.

• The peak review process can be made faster by caching previously calculated chromatograms. Refer to Edit
Menu on page 15.

Peak Review Right-Click Menu
These features control the appearance of the integration parameters that are shown to the left of the
chromatograms. Right-click in the Peak Review pane to access a context menu. The following commands are
available.

Table 8-1 Peak Review Parameters

CommandsTask

Peak Review Options Dialog: Appearance Tab on page
65 or Peak Review Options Dialog: Zooming Tab on
page 67.

Change the appearance of the Peak Review pane.

Set Peak Review Title Format on page 68.Set the peak review title format.

By default, the Show Parameters-Normal Width
is always set.

Show the parameters using descriptive names for the
individual parameters.

Copy Parameters on page 69.Copy the parameters.

Paste Parameters on page 69.Paste the parameters.

Set Peak to 'Not Found' on page 70.Set the peak to ‘Not Found’.

Use Peak on page 70.Use the peak.

Update Quantitation Method for Component on page
70.

Update the quantitation method for the component.

Update Quantitation Method for Group on page 70.Update the quantitation method for the group.

Apply Integration Parameters to Sample Within Group
on page 71.

Apply the integration parameters to a sample within
the group.

Revert Peak to Original Method on page 71.Revert the peak to the original method.

Revert All Peaks for Component on page 71.Revert all peaks for the component.

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C64 / 169

Peak Review



Peak Review Options Dialog: Appearance Tab
Right-click in the Peak Review pane to select to adjust options affecting the appearance of the Peak Review
pane. It is recommended that no more than four rows and four columns are set.

Figure 8-2 Peak Review Options Dialog: Appearance Tab
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DescriptionLabel

Controls the number of chromatograms that are simultaneously visible. Unless
chromatograms have already been cached, it will take longer to scroll between pages
if many chromatograms are shown. Refer to Edit Menu on page 15.

Number of rows and
Number of columns

Determines whether other chromatograms should be overlaid on top of the main
chromatogram in each of the sub-panes.
• Don't Overlay: Prevents overlay of other chromatograms.

• All components for group: Overlays all chromatograms for components
from the same group as the main component (for the current sample).

• Analytes and IS’s separately for group: Similar to the previous option,
except that rather than overlaying all components from the same group, analytes
and internal standards are kept separate.

• Internal Standard with Analyte: For analytes, overlays the internal standard
used by the analyte (internal standard chromatograms do not have other overlays).

• Qualifier and Quantifier with Ion Ratio Lines: Shows the ion ratio lines.
Select this option to visualize the ion ratio acceptance in the Results Table.
Users can view the ion ratio acceptance when there are groups defined in the
quantitation method. However, the Ion Ratio Lines are only an indication of
the acceptance and not the final result. The lines are shown in the chromatogram
as the peak height but the lines are calculated based on the peak area or height
depending on the settings defined in the quantitation method. If there is a
discrepancy between the height and area, then the user must confirm the Ion
Ratio outlier in the Results Table.

Overlay

Indicates how the currently active chromatogram should be shown. Set to use the
bold, italic title, and the grey background.

Highlight active graph
using:

Indicates how the integrated area for peaks should be shown. The choices are:

• Use a dotted style as used in the screen captures in this document.

• Use a solid style.

• Use no fill. In all cases the baseline for the peak is also drawn (in red).

When the third option is used, only the baseline is drawn and the peak is not filled.

Fill peaks

Indicates the Expected Retention Time with a blue arrow drawn below the
time axis. This can be useful to determine whether the integrated peak is near the
expected RT.

Mark expected RT with
arrow
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Peak Review Options Dialog: Zooming Tab
Right-click in the Peak Review pane to select to adjust options affecting the appearance of the Peak Review
pane. The Zoom intensity axis to features are used to automatically adjust the y-axis of the chromatograms.

Figure 8-3 Peak Review Options Dialog: Zooming Tab

DescriptionLabel

When selected, the x-axis of the chromatograms is automatically adjusted so that
only a portion of the entire run is visible. This is useful for long LC runs so that the
region of interest can be seen more clearly. The window width is expressed in terms
of a multiple of the RT Window integration parameter. The total width of the zoomed
region is twice the specified number of multiples of the RT Window.

Zoom time axis to view
peak

Used to automatically adjust the y-axis of the chromatograms. Scales the y-axis to
the specified percentage of the largest peak within the visible x-range of the
chromatogram. This will be smaller than the total LC run length if the Zoom time
axis to view peak feature is used.

Zoom intensity axis to
percent of largest peak

Used to automatically adjust the y-axis of the chromatograms. Used to focus on the
baseline region itself.

Zoom intensity axis to
times the baseline height

Scales the y-axis directly to the specified value.Zoom intensity axis to cps
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DescriptionLabel

Scales the y-axis to the smaller of the specified value or the largest peak.Zoom intensity axis to cps,
or largest peak

Maintains the settings from the Zoom intensity axis to the section using only the
main data set. This setting can cause the overlays to be only partially visible if they
are more intense than the main data set.

When overlaying Zoom
y-axis NOT using overlays

Uses the main data set and all overlays and uses the biggest overall y-value. This
feature always keeps the overlays visible.

When overlaying Zoom
y-axis using overlays

Scales the main data set and the overlays separately using a percentage scale. This
causes each trace to use the full available height. However, the relative peak heights
cannot be directly visually compared.

When overlaying Use a
percentage y-axis

Tip! Double-click within the y-axis to scale the axis to the most intense peak within the entire data set.

When selected, the chromatogram for the peak currently being reviewed is drawn using a solid blue trace and its
integrated peak area is shown. The chromatograms (not the integrated peak area) for the other components (for
the same sample) are overlaid using a dashed line.

When the graph is showing overlays in this way, double-click anywhere in the title area to toggle between showing
the titles for all chromatograms or just for the active one.

Tip! Double-click within the x-axis to return the graph to its home view in which all data is visible. Zoom in by
dragging within the axis to select a time range.

Set Peak Review Title Format
Use the dialog to customize the information that appears in the graph title for each of the chromatograms. If the
user types a column name in the Results Table in square brackets, then it is replaced by the field value for the
current sample and component. The user can also type any additional text that is left as is. It is recommended that
the sample name [Sample Name] be included in the peak review title.

• Right-click in the Peak Review pane and then click Set Peak Review Title Format
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Figure 8-4 Title Format Dialog

Copy Parameters
Right-click in the Peak Review pane to access this command. Use this command in conjunction with Paste
Parameters to copy the peak-finding parameters from one chromatogram to another. This command can be
used if the same adjustment to the parameters needs to be made for several chromatograms.

1. In a graph with an active chromatogram open, right-click and then click Copy Parameters.

2. Use the Update Quantitation Method for Component command to apply the change to all
chromatograms for the component.

Paste Parameters

1. In a graph with an active chromatogram open, right-click and then click Copy Parameters.

2. Right-click in a different chromatogram and then click Paste Parameters.

The previously copied parameters are applied to the new chromatogram.
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Set Peak to 'Not Found'

• In a graph with an active chromatogram open, right-click and then click Set Peak to ‘Not Found’ to remove
the integration from the selected chromatogram.

Use Peak

• In a graph with an active chromatogram open, right-click and then click Use Peak to include or exclude the
active peak from the calibration curve.

Update Quantitation Method for Component
After adjusting the peak-finding parameters for a particular chromatogram, select this feature to adjust the copy
of the quantitation method saved with the Results Table to use those parameters for the component.

• Adjust the peak-finding parameters, right-click, and then click Update Quantitation Method for
Component.

For the particular component, all samples are automatically integrated to use the new parameters and the
Peak Review pane and Results Table are updated. If any peaks have been manually integrated, then the
user is asked if the re-integration should apply to all peaks or only to those that were not manually integrated.

Update Quantitation Method for Group
Similar to the Update Quantitation Method for Component command, except that the integration
applies to all components that belong to the same group as the component for the currently active chromatogram.
If the user has assigned the various components to groups, and if the components assigned to any given group
are expected to have the same retention time, then this feature is useful so that the user can reset the parameters,
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including the expected retention time, for all components for the group at once. This feature is not useful if the
components for the groups do not have the same retention times.

• Adjust the peak-finding parameters, right-click, and then click Update Quantitation Method for Group.

Apply Integration Parameters to Sample Within Group
After adjusting the peak-finding parameters for a specific chromatogram, use this feature to apply the original
parameters from the copy of the quantitation method saved with the Results Table to the chromatogram.

• After adjusting the peak-finding parameters for a specific chromatogram, right-click and then click Apply
Integration Parameters to Sample Within Group.

Revert Peak to Original Method
After adjusting the peak-finding parameters for a specific chromatogram, use this feature to apply the original
parameters from the copy of the quantitation method saved with the Results Table to the chromatogram.

• Right-click and then click Revert Peak to Original Method.

Revert All Peaks for Component
After adjusting the peak-finding parameters for some chromatograms, use this feature to apply the original
parameters from the copy of the quantitation method saved with the Results Table to all chromatograms for
the same component as the active chromatogram. If any peaks have been manually integrated, then the user is
asked if the re-integration should apply to all peaks or only to those that were not manually integrated.

• Right-click and then click Revert All Peaks for Component.
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Use the Side-by-side Sample Review feature to screen for particular target compounds. Users can select up
to six samples to compare the peak responses across the samples. Reviewers should review the quantitative data
according to the criteria of peak integration and data acceptance in their own standard operating procedures
(SOPs).

When a Results Table is active, click the Side by Side Sample Review icon in the Results Table tool
bar to open the Side by Side Sample Review pane.

Figure 9-1 Side by Side Sample Review Pane

Quantitation methods include the criteria used to quantitate the peaks selected for integration. Reviewers should
review the quantitative data according to the criteria of peak integration and data acceptance in their own SOPs.

Perform a Side-by-Side Sample Review

1. Open a Results Table.

2. Click the Side by Side Sample Review icon.

3. Select a sample from the list in the Side by Side Sample Review pane.

The integration parameters are shown.
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Tip! Right-click in the Side by Side Sample Review pane and then click Options to change the
number of rows or columns in the side-by-side review.

4. Select another sample from the other list.
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Use the Calibration pane to visually inspect the regression for each analyte, if Standard samples of a known
concentration are used. This pane is not applicable if the user is performing relative quantitation and does not
have Standard samples. When a Results Table is active, click Show Calibration in the too lbar.

Figure 10-1 Calibration Pane

As well as inspecting the regression, the user can exclude Standard samples so that they are not used for the
regression. After adjustments are made, a new regression is automatically calculated and parameters such as the
Calculated Concentration and Accuracy are recalculated for all samples for the analyte. Refer to Regression
Equations on page 128.

Regression Options Dialog
If there are many analytes, then it is easier to apply changes using the Regression Options dialog than by
changing the regression parameters one-by-one.
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Figure 10-2 Regression Options Dialog

Calibration Tips
• For analytes without an associated internal standard, the y-axis is peak Area or Height as selected in the

quantitation method. For analytes with an internal standard, the y-axis is the peak Area or Height ratio (of
the analyte to the internal standard).

• For analytes without an associated internal standard, the x-axis is Actual Concentration. Otherwise, it is
the Actual Concentration ratio (of the analyte to the internal standard).

• If more than one analyte from the Components & Groups List is selected, then calibrations for all analytes
are overlaid. Otherwise, the calibration for the selected analyte is shown.

• The title region always shows the name of the active analyte and the associated regression equation with the
correlation co-efficient. If the regression could not be calculated, for example if there are no Standard samples,
then the title indicates this. If calibrations for multiple analytes are overlaid, then toggle the title between
showing information for all analytes or just the active one by double-clicking anywhere within the title region.
If there are many overlaid analytes, then it might not be possible to display all information. In this case, scroll
the title by dragging within it.

• The data points for the Standard samples that are in use are always plotted as is the calibration equation
that uses these points. The user can optionally show data points for excluded Standard samples and for
Quality Control samples.

• If the user clicks a data point, then the corresponding row in the Results Table is automatically selected and
scrolled into view, provided that the row is currently visible somewhere in the table and has not been hidden.
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Calibration Right-Click Menu
Right-click in the Calibration pane to access a context menu. The following commands are available.

Table 10-1 Calibration Pane Right-Click Menu Options

DescriptionMenu Option

If the user right-clicks directly on a data point for a standard that has not been
excluded, then this option is used to exclude the sample from the regression
calculation (for the sample and analyte for the clicked data point). If the sample has
already been excluded, then the text of the menu item reads Include and selecting
it includes that point. After selection, the regression is calculated and the Results
Table is updated. This functionality is equivalent to clearing or selecting the Used
check box in the Results Table for the corresponding row.

Exclude (or Include)

Excludes or includes all analytes, not only the analyte corresponding to a selected
data point.

Exclude – All Analytes (or
Include – All Analytes)

When selected, data points for excluded standards (if any) are drawn using open
circles. When cleared, excluded standards are not shown.

Show Excluded Standards

When selected, data points for Quality Control (QC) samples are drawn using
an open diamond. When cleared, the QC samples are not shown.

Show QCs

When selected, a legend is drawn to the right of the plot that shows the point symbols
for the various sample types (closed circles for Standard samples, open circles for
excluded Standards, and open diamonds for Quality Control samples).

Note: If the user is not viewing certain sample types, for example if the Show
QCs option is not selected, then the entry for those sample types is not present.
If neither QC samples nor excluded standards are shown, then this option is not
available and no legend is drawn.

Show Legend

When not selected, the y-axis for the plot is in units of absolute peak Area or
Height (or the peak Area or Height ratio if an internal standard is being used).
When selected, the y-axis is expressed as a percentage of the data point with the
largest y-value for each analyte independently.

Using a percentage axis is useful if more than one analyte is overlaid and their
absolute responses are fairly different since it allows each trace to be scaled to use
the entire available vertical area. Otherwise, analytes with low response lie close to
the x-axis and the plot need to be zoomed to see them in detail.

Use Percent Y-Axis

Used to toggle the view between plotting Area versus Concentration and
Log(Area) versus Log(Concentration).

Log-Log Plot
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Use the Statistics Table to view information related to the reproducibility of an analysis. Each row of the table
summarizes information such as the average and standard deviation for a group of related peaks from the same
analyte that would ideally be expected to have the same response.

Figure 11-1 Statistics Pane

DescriptionLabel

The row number. Click one of the other column headers to sort the table. Return the
table to the original view by clicking this header.

Row

The name of the analyte.Component Name

If grouping by actual concentration, then this column shows the concentration. If
grouping by sample name, then the title of the column changes and the sample
name is shown.

Actual Concentration (or
Sample Name)

Shows m of n where n is the total number of samples at the actual concentration
(or with the same sample name) and m is the number of these samples used for the
calculations. Samples are not used if the corresponding peak could not be integrated
or if the Used field has been manually cleared.

Num. Values

The average for the used samples.Mean

The standard deviation of the used samples.Standard Deviation

The co-efficient of variance expressed as a percentage: 100 * (Standard Deviation)
/ Mean.

Percent CV

MultiQuantTM MD 3.0.3 SoftwareReference Guide
77 / 169IVD-IDV-06-0904-C

11Statistics Tables



DescriptionLabel

The mean value divided by the actual concentration expressed as a percentage: 100
* Mean / (Actual Concentration). This field is shown only when grouping by actual
concentration, not when grouping by sample name.

Accuracy

The individual values for the samples appear in additional columns. If the
corresponding sample could not be integrated, then the value is N/A. If the Used
field has been manually cleared, the value is shown with a strike-through line.

Values

Statistics Table Tips
• The Statistics Table links to the Components & Groups List to show rows corresponding to the selected

analytes. If the All Components or All Analytes items are selected, then there are entries for all analytes.
If an individual analyte is selected, then there are entries for that analyte only. If an individual internal standard
is selected from the list, then the Statistics Table is blank. Refer to Components & Groups List on page 38.

• If the user clicks one of the Value cells, then the corresponding row in the Results Table for the analyte
and sample is selected provided that the row is currently visible in the Statistics Table. Only Unknown
samples in the Results Table are shown. If the Statistics Table contains information for Standard
samples, then the corresponding rows are not visible in the Results Table. If the Peak Review pane is
visible, then it links to the Results Table and it is updated when the cell is clicked.

• Click one of the column headings to sort the Statistics Table.

• The user can copy either the whole Statistics Table or just the rows of interest.

• To copy the whole table, click Edit > Copy.

• To copy just the rows of interest, manually select the rows and then click Edit > Copy.

• If the column widths are adjusted, then these widths are restored the next time the Statistics Table is shown.

• The format and precision are the same as those in the Results Table.

• The Group by Concentration for Standards and QCs is based on Displayed Actual
Concentration, not the Actual Concentration stored in the Results Table. If the Std 1 concentration
is 0.001, the Std 2 concentration is 0.005, and the display format is 0, then Std 1 and Std 2 are grouped together
because both of them are treated as 0. To group them separately, in the Column Settings dialog, set the
precision for Analyte Concentration to 0.000. If Std 1 is 0.500 and Std 2 is 0.499, then set the precision
to 0.00 to group them together.

Statistics Table Right-Click Menu
Right-click in the Statistics Table to access the Use Peak command. Use this command to set the Used field
for the sample and analyte corresponding to the selected cell in one of the Value columns. Before right-clicking
to obtain the menu, click the appropriate cell in one of the Value columns to select it.
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Use Metric Plots to plot the values in a Results Table column against either the row number or another column.
These plots are a valuable aid for visual data review, especially if users do not want to manually review every
chromatogram using the Peak Review pane.

Generate a Metric Plot

1. Select one or two columns in the Results Table.

2. Click Show Metric Plot.

If one column is selected, then the resulting plot shows the values from the column as a function of row number
in the table. If two columns are selected, then the values from the columns are plotted against one another.
The first of the two columns to be selected contains the x values and the second contains the y values.

Save Metric Plot Settings

1. Open a metric plot by selecting a column and then click Show Metric Plot.

2. Right-click in the plot and then clicking Save Setting.

This enables the user to quickly generate Metric Plots that are frequently used without having to select the
corresponding column each time.

Metric Plot Tips
• If users left-click on a data point, then the corresponding row of the Results Table is automatically selected

and scrolled into view. If the Peak Review pane is open, then it also updates to show the corresponding
chromatogram. This provides a convenient means of performing peak review for outliers.

• If more than one component from the Components & Groups list is selected, then the traces for all of the
components are overlaid. Otherwise, the trace for the one selected component is shown.

• The title region always shows the name of the active trace. If traces for multiple components are overlaid, then
toggle the title between showing information for all of the traces or just the active one by double-clicking
anywhere within the title region. Activate a particular trace by clicking the color spot to the left of the
corresponding title.
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• Save the settings for the Metric plot to use again. Right-click in the Metric plot and then click Save Settings
As.

Metric Plot Right-Click Menu
Right-click in the Metric Plot to access a context menu. The following commands are available.

Table 12-1 Metric Plot Right-Click Menu Options

DescriptionMenu Option

Shows a regression line on the metric plot.
• Regression Type

• Weighting Type

• Include standard deviation lines and Multiplier

Refer to Regression Dialog on page 81.

Regression

When this option is selected, plots values that are not numerical using a y-value of
zero. Otherwise, such points are omitted from the plot. For example, the Retention
Time is reported as N/A for peaks that could not be integrated. For this feature, a
point is present for such peaks so that the user can see these potentially problematic
samples and then link them to the Peak Review pane by clicking the point.

Display “N/A” as 0.0

Changes the legend that annotates the point symbols used for the various sample
types.

Show Legend

Changes whether the data points are labeled using the text from the Sample Name
field of the Results Table. If there is more than one overlaid trace, then only the
currently active trace is labeled.

Label Active Series (using
sample names)

Changes whether the y-axis uses absolute units or a percentage of the maximum
y-value. When using the percentage feature, the percentage is calculated
independently for each overlaid trace. This feature can be used to plot overlaid traces
for multiple components and the response for the metric for the components is
significantly different.

Use Percent Y-Axis

Changes whether the y-axis starts at y=0 or at the minimum y-value needing to be
plotted.

Start Y-Axis at Zero

Changes whether the data points are connected by lines.Connect Points With Lines

If the plot is currently associated with a setting, then this feature saves the current
features. Otherwise, this feature behaves the same as the Save Setting As feature.

Save Setting
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Table 12-1 Metric Plot Right-Click Menu Options (continued)

DescriptionMenu Option

If the same columns are frequently plotted, then the user can save the plotting
options as a setting. This enables the user to quickly generate a plot even if the
required columns are not currently visible in the Results Table. In addition to the
columns, the various plotting options are saved. After a setting is saved, the name
is shown in the Metric Plot menu.

Save Setting As

If the current plot is associated with a setting, then use this feature to delete the
setting.

Delete Setting

Regression Dialog
Click to show a regression line on the metric plot.

Figure 12-1 Regression Dialog
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DescriptionLabel

Contains the various regression types (linear, quadratic, and so on). The Mean
regression type results in a horizontal line at the location of the average y-value
for all of the data points and for the Median regression type results in a horizontal
line at the location of the median y-value for the points. In addition, there is a None
feature that removes any previous regression.

Regression Type

The various weighting types are described in Weighting Factors on page 129.Weighting Type

These options are available when either the Mean or Median regression type is
selected. When selected, additional dashed horizontal lines are added to plot the
specified number of standard deviations above and below the main line. Use this
option to view points that are, for example, more than two or three standard
deviations from the average.

Include standard deviation
lines and Multiplier
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Use the Quantitation Method Editor to create a quantitation method or to edit an existing one.

The typical workflow is to create quantitation methods using the New Results Table wizard. However, the
user can use the Quantitation Method Editor to create a quantitation method that can be used as required.

Components Tab
Right-click in the Components tab to access a context menu. The following commands are available.

Table 13-1 Components Right-Click Menu Options

DescriptionMenu Option

Used to select the component whose Name matches the text. The exact text is not
required to find a match. This is useful to select a specific component if there are
many components.

If no row is initially selected in the spreadsheet, then the search starts from the first
row. Otherwise the search starts from the row following the selected row and wraps
around to the beginning. This is useful if there is more than one component whose
Name contains the text. If the first search does not find the component, search
again, leaving the first component selected, to locate another match in the table.

Find Component by Name

Inserts a single empty row immediately above the currently selected row.Insert Row Above

Removes the currently selected rows from the table.Delete Selected Rows

Sums chromatograms for multiple MRM transitions or full-scan mass ranges. After
the command is selected, additional mass columns are added to the Components
table. Any masses selected for a given row are used in the construction of the summed
XIC for the corresponding analyte or internal standard. It is recommended that this
feature is always selected.

Sum Multiple Ions

Refer to Groups Submenu on page 84.Groups

Refer to Internal Standards Submenu on page 86.Internal Standards
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Groups Submenu

Table 13-2 Groups Menu Options

DescriptionMenu Option

Opens the Set Automatic Groups dialog, which is used to automatically populate the
Group column using the name of the first component for each group, assuming that
each group contains the same number of components. Refer to Set Automatic Groups
Dialog on page 85.

Using Constant Group
Size

Automatically completes the same group name for a number of sequential components.

To use the command, manually specify the group name for the first component for each
separate group and then select the command. The specified group names are filled-down
to any subsequent components for which the group name is blank. Only rows for which
the Name has been filled in are considered.

By Filling Down
Existing Groups

Only available for MRM experiments. Used to populate the Group column using the Q1
mass. This is useful if the same Q1 mass was specified for multiple transitions for the
same compound and different fragments were monitored. If there are many components,
and if some coincidentally share the same Q1 mass, then they are assigned to the same
group.

Using Q1 Masses

Only available for MRM experiments. Used to populate the Group column using the Q3
mass. This is useful if different isotopic forms of a compound were monitored (with
different Q1 masses), but a constant Q3 mass was monitored. If there are many
components, and if some coincidentally share the same Q3 mass, then they are assigned
to the same group.

Using Q3 Masses

Used to populate the Group column using the difference between the Q1 and Q3 masses
(only available for MRM experiments). This is useful if different isotopic forms of a
compound were monitored (with different Q1 masses), but a consistent Q3 fragment
containing all modified isotopes was monitored. If there are many components and if
some coincidentally share the same mass difference, then they are assigned to the same
group.

Using (Q1 – Q3) Mass
Differences

Appends the group name to the beginning of the analyte or internal standard name.
This can be useful if the initial names are not unique.

Add Group to Start of
Component Name
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Table 13-2 Groups Menu Options (continued)

DescriptionMenu Option

Removes the group name, if present, from the beginning of the analyte or internal
standard name.

Remove Group from
Start of Component
Name

When the Sum Multiple Ions option is enabled, this command appends a new component
for each group that uses the summed chromatogram for the group. Separate components
are added for analytes and internal standards for the groups, if both are defined. The
name for the new analytes defaults to the group name and for internal standards to the
group name with .IS appended. If the summed components are required and not the
original single-mass components, then the latter can be deleted.

Append Summed Ions
for Groups

Set Automatic Groups Dialog

Automatically populates the Group column using the name of the first component for each group, assuming that
each group contains the same number of components.

Figure 13-1 Set Automatic Groups Dialog

DescriptionLabel

The total number of components for each group.Number of components
per group

The offset in rows between sequential components in the same group. This value is
usually 1, but can be larger if the components for the group are not in adjacent rows.

Offset between
components in same
group
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Internal Standards Submenu

Table 13-3 Internal Standards Menu Options

DescriptionMenu Option

Sets the IS Name field for all of the analyte rows. If one internal standard has been
defined, then its name is used. Otherwise, select the required internal standard
from the dialog that opens.

Set IS for All Analytes

If the same internal standard is used for more than one analyte, then provide a
shortcut to setting the internal standard separately for each analyte one-by-one.
Refer to Set IS for Selected Analytes on page 86.

Set IS for Selected Analytes

Use this command if the various components have been assigned to Groups, either
manually or by using the items from the Set Groups submenu. The IS check box
for the last component for each group is selected and all of the other components
for the group, which are assumed to be analytes, are set to use that last component
as an internal standard.

Set Last Component of
Group as IS

Used to copy the arrangement of internal standards for the group corresponding
to the currently selected row to all of the other groups, in a symmetrical way. This
is useful if there is more than one internal standard for each of the groups.  Refer
to Set for All Groups as for Selected Group on page 86.

Set for All Groups as for
Selected Group

Set IS for Selected Analytes

1. Make sure that the required internal standard is defined (both the Name and the IS check box are selected).

2. Select the rows for the analytes for which to use the internal standard.

3. Select the menu item.

If there is more than one internal standard defined, then a dialog opens prompting the user to select the
required one.

Set for All Groups as for Selected Group

1. Assign groups.

2. Manually indicate which components are internal standards by selecting the box in the first column for the
first group.

3. Manually indicate the internal standard for each analyte for the first group by selecting from the combo-box
in the IS Name column.

4. Select any single row corresponding to the first group.

5. Click Set for All Groups as for Selected Group.
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Integration Tab
Right-click in the Integration tab to access a context menu. The following commands are available.

Table 13-4 Integration & Regression Tab Right-Click Menu Options

DescriptionMenu Option

Similar to the command available from the Components tab, except the difference
is that instead of selecting rows of the Components spreadsheet, individual items
in the components list are selected.

Find Component by Name

Used to highlight those components for which the default expected retention time
(taken as the RT of the peak with the largest intensity for each chromatogram) is
incorrect. If there are only a few components, then review each one individually and
do not use this command. However, if there are many components, then use this
command to visually check only those for which there is more than one significant
peak present in the chromatogram. Refer to Highlight Components Dialog on page
88.

Highlight Components with
Uncertain RT

Returns the zoomed graph to its home view where all data is visible.Home Graph Axes

Use this command to overlay chromatograms if various components have been
assigned to groups, and if the components assigned to any given group are expected
to have the same retention time. For example, if they represent different MRM
transitions of the same actual compound.

When selected, the chromatogram for the current component, whose integration
parameters are being defined, is drawn using a solid blue trace and its integrated
peak area is shown. The chromatograms, and not the integrated peak area, for the
other components in the same group are overlaid using a dashed line style.

Overlay Other Components
for Group

Used to reset the expected retention times for a previously created quantitation
method. If an existing quantitation method is opened and Set New Typical
Sample is selected, then the chromatograms shown correspond to the new sample
but the expected retention times are left unchanged.

For each component, the expected retention time is updated to correspond to the
retention time of the peak with the largest intensity within a window of the specified
width centered at the original expected retention time. Refer to Update Retention
Time Dialog on page 88.

Update Retention Times

Used to associate a representative sample with the method. This potentially affects
the selections available from the Q1/Q3 column (for MRM experiments) or Start
- Stop column (for profile experiments). It also affects the chromatograms that are
displayed on the Integration tab.

Set New Typical Sample
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Highlight Components Dialog
The names of any components for which the automatically selected peak does not account for at least the specified
percentage of the total peak area in the chromatogram are indicated using bold type. For example, in Figure 13-2,
if the default selected peak accounts for 70% to 100% of the total area, then it is not flagged. Review only these
peaks by selecting them from the components list.

If the Only show this dialog again if the shift key is down check box is selected, then the dialog does
not open the next time the command is selected, unless the user presses Shift. The previously specified total area
percentage parameter is used automatically.

Figure 13-2 Highlight Components Dialog

Update Retention Time Dialog
Used to reset the expected retention times for a previously created quantitation method. If an existing quantitation
method is opened and Set New Typical Sample is selected, then the chromatograms shown correspond to the new
sample but the expected retention times are left unchanged.

For each component, the expected retention time is updated to correspond to the retention time of the peak with
the largest intensity within a window of the specified width centered at the original expected retention time.

If the Only show this dialog again if the shift key is down check box is selected, then the dialog does
not open the next time the command is selected, unless the user presses Shift. The previously specified retention
time is used automatically.
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Figure 13-3 Highlight Components Dialog

Outlier Settings Tab
Right-click in the Outlier Settings tab to access a context menu. The following commands are available.

DescriptionLabel

Edits the accuracy tolerance of the Standard samples.Accuracy for Standards

Edits the accuracy tolerance for the Standard samples with a value that is consistent
with the laboratory standard operating procedures.

Max. Accuracy Tolerance
for Stds except LLOQ%

Edits the accuracy tolerance for the lowest concentration Standard if the laboratory
standard operating procedure indicates a different tolerance for this Standard.

Max. Accuracy Tolerance
for LLOQ (lowest Std)%

Edits the accuracy tolerance of the Quality Control samples.Accuracy for QCs

Edits the accuracy tolerance for the Quality Control samples with a value that
is consistent with the laboratory standard operating procedures.

Max. Accuracy Tolerance
for QC%

Only available if the components are assigned to groups. Select to use the ion ratio
of the peak area or peak height. Peak area or peak height is set when selecting the
regression parameter during quantitation method development.

Ion Ratio

When using Standard samples of known concentration, this is the back-calculated
concentration from the calibration curve. Regression equations describe how the
regression is performed for the various regression types and weighting.

Calculated Concentration

The analytes or internal standards for all samples.Component

The selected internal standard. Only available if the Ion Ratio check box is selected.IS

Components that have the same retention time (that is, different transitions for the
same compound) can be grouped. Only available if the Ion Ratio check box is
selected.

Group
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DescriptionLabel

Use the default setting or edit this setting according to laboratory standard operating
procedures. Only available if the Ion Ratio check box is selected.

Ion Ratio Tolerance (%)

Type the lower limit of the acceptable concentration range. Any sample with the
Calculated Concentration lower than this value is flagged as a concentration
outlier.

Lower Limit of Calculated
Concentration

Type the upper limit of the acceptable concentration range. Any sample with the
Calculated Concentration higher than this value is flagged as a concentration
outlier.

Upper Limit of Calculated
Concentration

Table 13-5 Outlier Settings Right-Click Menu Options

DescriptionLabel

Applies the lower limit of the calculated concentration
to all of the analytes, if all of the analytes have the same
criteria.

Apply to all analytes the Lower Limit of Calc.
Concentration

Applies the upper limit of the calculated concentration
to all of the analytes, if all of the analytes have the same
criteria.

Apply to all analytes the Upper Limit of Calc.
Concentration
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Objectives:

• Learn how to process data using the SignalFinderTM algorithm.

• Learn how to process data using the MQ4 integration algorithm.

• Learn how to use the MQ4 and SignalFinderTM integration algorithm parameters.

Quantitation methods include a set of instructions on how to quantitate the peaks selected for integration. In this
tutorial, a quantitation method is created at the same time as the Results Table.

Also included are additional tasks that can be used to manipulate the data in the Results Table, as well as
information about the available software icons.

Note: Audit Trail and Security edition users are restricted to using the Analyst Data folder structure. Users can
only process data files that are in the Analyst

®
 MD software file structure. If the file and folder structure are not

maintained, then the user might not be able to view the chromatograms.

About Calibration Curves
A calibration curve (also know as a standard concentration curve) is a method for determining the concentration
of a substance in an Unknown sample by comparing the Unknown sample to a set of Standard samples
of known concentration. The calibration curve is a plot of how the instrument responds (the analytical signal) to
changes to the concentration of the analyte (the substance to be measured). The user prepares a series of Standard
samples across a range of concentrations near the expected concentration of the analyte in the Unknown sample.

Prerequisites
In the Analyst

®
 MD software, select the Example project.

The Mix_batch_1. Wiff file can be found in the Analyst Data\Projects\Example\Data\Triple Quad folder.

Modify the Columns Shown in the Results Table
Use this procedure to show or hide columns in the Results Table or change the precision of the number format.
For numerical fields, use the format 0.00 for non-scientific notations and use the format 0.00e0 for scientific
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notations. Change the decimal points to indicate the precision of the numbers that are shown. Only a period (.)
can be used as a decimal separator. Digit grouping is not supported.

Note: Some critical columns of the sample information such as Sample Name, Sample ID, and so on should
not be hidden when users customize the Results Table column settings.

1. Right-click in the Results Table and then click Column Settings.

Figure 14-1 Column Settings Dialog

2. Select or clear the check box in the Visible column as required.

3. In the Number Format column, change the format to integer or scientific notation. The number of decimal
points to be shown can also be changed.

Tip! To apply the column settings to all Results Tables in the project, select the Save as project
default check box.

4. Click OK.

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C92 / 169

Quantitation Analysis Workflow Tutorial



Process Data Using the SignalFinderTM Integration
Algorithm
Unlike the MQ4 integration algorithm or the algorithms available in the Analyst

®
 MD software, the SignalFinderTM

builds a peak model using the selected sample when creating a quantitation method. This model describes the
shape of the selected peak used by the algorithm. At integration time, the SignalFinder integration algorithm
applies this model to the other samples, stretching or skewing the sample. This allows for the fact that the peak
shape is similar, but not identical, for a given analyte or internal standard for multiple samples.

Set the Peak Integration Parameters
Use the following procedure to check or set the integration algorithm processing the data. Refer to About the
SignalFinder Integration Algorithm on page 110.

1. In the Analyst
®
 MD software, on the Navigation bar, under Companion Software, double-click

MultiQuant 3.0.3.

2. Click Edit > Project Integration Defaults.

3. In the Integration Defaults dialog, select SignalFinder1 from the Integration Algorithm list.

4. Select the Use Saturation Correction check box and then set the Saturation Threshold to 1.8E+006.
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Figure 14-2 Integration Defaults Dialog

Note: Peaks above the Saturation Threshold are considered saturated. This value is detector-dependent.

5. Click OK.

Create a Results Table

1. Click File > New Results Table.

2. On the Create Results Table - Select Samples page, expand the Example Data folder and then drag
the Mix_batch_1.wiff file into the Selected pane.

3. Click Next.

4. Click the Create New Method (SignalFinder1) option.

5. Click New.

6. Type a name for the method in the Save Quantitation Method As dialog and then click Save.

7. Click Next.
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On the Create Results Table - Select Representative Sample page a representative sample has been
selected. The software recommends a representative sample based on selecting a chromatogram that provides
the best opportunity to select integration parameters that fit the entire batch. It is recommended to select a
non-saturated, high concentration standard or QC sample (TIC below 1E+006 cps).

Tip! During peak review, another sample from which to build a peak model during peak review can be
selected.

Figure 14-3 Create Results Table - Select Representative Sample Page

8. On the Create Results Table - Define Components page, confirm the analytes and internal standards.

9. Click Next.
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Figure 14-4 Create Results Table - Define Components Page

Note: When an acquisition method is created, if the component name is included in the ID column in the
mass ranges table, then that name is populated automatically in the Define Components page. If the
component name was not included, then manually update the table with the component name.

On the Create Results Table - Define Integration page, the analytes and internal standards are shown
on the left side. The current integration parameters have been applied to the representative sample and the
chromatogram is shown.

The components of the representative sample previously selected are shown in the Integration pane. Peaks
in this representative sample are found and integrated using the parameters that were set in the Integration
Defaults dialog.
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Figure 14-5 Create Results Table - Define Integration Page

If required, adjust the peak-finding parameters and the positions of the green arrows in the x-axis of the
chromatograms. This enables the user to more precisely set the required starting and ending position of peak
integration. Effectively, this is a visual way of adjusting two peak-finding parameters that are saved with the
quantitation method and applied to all peaks to be integrated. The software constrains the limits of these
parameters within what it considers to be reasonable limits for the extent of the peak.

If there is more than one peak in the chromatogram and the correct peak has not been selected automatically,
then drag across a peak to set the expected retention time. Drag from the actual start to the actual end of the
peak and do not select a very wide or very narrow region. The reason is that the algorithm assumes that there
is just one peak within the selection. For example, if the data set is noisy and the algorithm finds two merged
peaks when there is only one peak present, then select a region containing both peaks to cause the algorithm
to adjust its internal parameters so that only one peak is found. Alternatively, if the algorithm has found one
peak when it is believed that there are two or more adjacent peaks present, then select a region spanning just
the peak of interest.

10. In the Integration Parameters group, select the Global Baseline check box to use the entire
chromatogram as the baseline.
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If this option is not selected, then the software considers only a narrow area around the peak of interest.

11. Select the Allow Non-Linear Baseline check box select between a linear or non-linear baseline. A non-linear
baseline estimates the baseline under each peak. A linear baseline fits a line between the points at the beginning
and end of that specific group of peaks.

12. Review the peak integration for each component by clicking the component name in the left pane. Adjust the
integration parameters to get the representative peak integrated properly.

13. For the components Minoxidol, Tolbutamide, and Reserpine, use the Regression group parameters
to set the following and then click Apply:

• Parameter: Area

• Fit: Linear

• Weighting: None

14. Set Concentration Units to ng/mL and then select the Apply units to all Analytes check box.

15. Click Apply.

16. Click Finish.

The sample files are automatically integrated and a Results Table is generated.

Refer to Review Peaks on page 98 to manage the data in the Results Table. Refer to Reports on page 134
for information on creating reports.

Review Peaks

1. Click the Peak Review icon.

2. Right-click in the table and then click Column Settings.

3. Make the SF Saturated column visible.

4. Right-click in the Peak Review pane and then click Options.

5. In the Zooming tab, change the Zoom time axis to view peak to 1.

6. Set the Zoom intensity axis to 200 percent of largest peak.
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Figure 14-6 Peak Review Options

7. Use the red arrows to scroll through the peaks.

If the detector is saturated, then the peak appears flatter than normal. For example, this peak would have a
red profile around the peak and Yes appears in the SF Saturated column because the peak intensity is
above the saturation threshold of 1.86 cps.

Note: The representative sample might not be suitable for all components. A new representative sample
can be selected during peak review and a new model generated.

8. To create a new model, select a new peak and then click the Update Peak Model icon. Select a peak that
is similar in shape to the other peaks and is not saturated.

9. Right-click and then click Update Quantitation Method for Component to apply changes to all of
the samples in the component.

Modify the Calibration Curve

1. Click the Show Calibration Curve icon to view the calibration curve.

2. To add a legend, right-click in the Calibration pane and then click Show Legend.
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Figure 14-7 Calibration Curve

3. To add the QCs to the curve, right-click in the Calibration pane again and then click Show QCs.

Tip! To exclude a point from the curve, right-click a point on the curve and then click Exclude.

4. To confirm or edit the regression parameters for an individual analyte, select the analyte in the Components
and Group list and then click the Regression button on the tool bar.

Review Sample Statistics
Users can review statistics for a single Results Table. Reviewing the peak integration, the calibration curve, and
the sample statistics is an iterative process.

1. With a Results Table open, click the Show Statistics Table icon.

2. From the Sample Grouping list, click an item to specify how the sample (for a given analyte) should be
grouped for the calculation of the statistics.
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Figure 14-8 Statistics Pane

3. From the Metric list, click an item to specify the actual metric that is used for the calculation of the statistics.

4. Review the Value columns. The struck out points indicate excluded data points.

Process Data Using the MQ4 Integration Algorithm

Set the Peak Integration Parameters
Use the following procedure to check or set the integration algorithm before processing the data. Refer to MQ4
Integration Algorithm Parameters on page 117.

1. In the Analyst
®
 MD software, on the Navigation bar, under Companion Software, double-click

MultiQuant 3.0.3.

2. Click Edit > Project Integration Defaults.

3. In the Integration Defaults dialog, in the Integration Algorithm list, select MQ4.
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Figure 14-9 Integration Defaults Dialog

4. If required, change the parameters for the project and then click OK.

The MQ4 integration algorithm and parameter settings are used for any new methods created in this Example
project folder. These default settings are project-based. To change the default settings for other projects, repeat
this procedure for the selected project.

Create a Results Table

1. Click File > New Results Table.

2. On the Create Results Table - Select Samples page, expand the Example Data folder and then drag
the Mix_batch_1.wiff file into the Selected pane.

3. Click Next.

4. Click the Create New Method (MQ4) option.

5. Click New.
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6. Type a name for the method in the Save Quantitation Method As dialog and then click Save.

In this tutorial, a method is created. Creating methods provides an opportunity to review and apply different
parameters for the integration of the data.

If there is an existing method, then select the Choose Existing Method option and then select the Edit
Method check box to review and apply different parameters to the method. If the Edit Method check box
is not selected, then the wizard will create the Results Table using the existing method.

7. On the Create Results Table - Select Representative Sample  page, a representative sample has
been recommended and is selected.

Figure 14-10 Create Results Table - Select Representative Sample Page

8. Click Next.

The software recommends a representative sample based on selecting a chromatogram that provides the best
opportunity to select integration parameters that fit the entire batch. It is recommended that the second lowest
concentration standard or QC sample for the MQ4 integration algorithm is selected if the analyte concentration

MultiQuantTM MD 3.0.3 SoftwareReference Guide
103 / 169IVD-IDV-06-0904-C

Quantitation Analysis Workflow Tutorial



information is embedded in the .wiff file. For example, if the concentration range is from one to eight, then
the second lowest is two. If the default representative sample is not intense enough, then select another
representative sample by clicking the Back button in the wizard and then selecting another sample. Another
sample can be selected during peak review. Refer to Review Peaks on page 106.

9. On the Create Results Table - Define Components page, confirm the analytes and internal standards.

Figure 14-11 Create Results Table - Define Components Page

10. Click Next.

Note: When an acquisition method is created, if the component name is included in the ID column in the
mass ranges table, then that name is populated automatically in the Define Components page. If the
component name was not included, then manually update the table with the component name. If an .IS
extension is added to a component name, the software identifies the component as an internal standard and
assigns the .IS component as the internal standard to its matching analyte.
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On the Create Results Table - Define Integration page, the analytes and internal standards are shown
on the left side. The current integration parameters have been applied to the representative sample and the
chromatogram is shown.

The components of the representative sample previously selected are shown in the Integration pane. Peaks
in this representative sample are found and integrated using the parameters that were set in the Integration
Defaults dialog.

11. Review the peak integration for each component by clicking the component name in the left pane. Adjust the
integration parameters to get the representative peak integrated properly. Refer to Set the Peak Integration
Parameters on page 101.

Figure 14-12 Create Results Table - Define Integration Page
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12. For the components Minoxidol, Tolbutamide, and Reserpine, use the Regression group parameters
to set the following and then click Apply:

• Parameter: Area

• Fit: Linear

• Weighting: None

13. Set Concentration Units to ng/mL and then select the Apply units to all Analytes check box.

14. Click Apply.

15. Click Finish.

The sample files are automatically integrated and a Results Table is generated.

Figure 14-13 Results Table

Refer to Review Peaks on page 98 to manage the data in the Results Table. Refer to Reports on page 134 for
information on creating reports.

Review Peaks

1. Click the Peak Review icon.
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Figure 14-14 Peak Review Pane

2. Right-click in the table and then click Column Settings.

3. Right-click in the Peak Review pane and then click Options.

4. In the Zooming tab, change the Zoom time axis to view peak to 3 RT Windows.

5. If a chromatogram contains multiple peaks and an incorrect peak is integrated, then drag across the correct
peak to set a new Expected RT. If required, adjust the peak finding and integration parameters. Refer to
Integration Algorithms on page 109.

6. To apply the new parameters to all other samples, for the same component, right-click in the chromatogram
and then click Update Quantitation Method for Component.

7. The embedded quantitation method can be modified while viewing the Results Table by clicking Edit >
Modify Results Table Method. The user can change the integration parameter regression options and
component information for each component.

If the integration parameter regression options and component information for each component is changed,
then only the quantitation method embedded in the Results Table is modified. The actual quantitation
method file used to create the Results Table is not modified. To use this embedded quantitation method to
process other data files, export this embedded method to a method file using the Export function.

Note: Clear the integration by clicking Set Peak to Not Found to view the raw data before manually
integrating the peak.

8. To use the manual integration mode, click the Enable Manual Integration Mode icon in the Peak
Review pane. Drag the cursor from the base of one side of the peak of interest to the other. The peak is now
manually integrated and the integration parameters used previously are unavailable.
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Tip! If the peak has just been modified, then revert the peak to the original method by right-clicking and
then clicking Revert Peak to Original Method.

Note: The Calculated Concentration field in the Results Table reflects any changes resulting from
the fit of the curve to the points of the standard.

Modify the Calibration Curve

1. Click the Show Calibration Curve icon to view the calibration curve.

2. To add a legend, right-click in the Calibration pane and then click Show Legend.

3. To add the QCs to the curve, right-click in the Calibration pane again and then click Show QCs.

Tip! To exclude a point from the curve, right-click a point on the curve and then click Exclude.

4. To confirm or edit the regression parameters for an individual analyte, select the analyte in the Components
and Group pane and then click the Regression button on the tool bar.

5. To make the calibration curve fit better, exclude the second STD 2 sample (concentration 4.00 ng/mL) and the
first STD 7 sample (concentration 128.00 ng/mL). To do this, use the Actual Concentration column and
the Used column to remove the samples. Clear the check box in the Used column to remove the point from
the curve. The calibration curve should now look like the one shown in Figure 14-15.

Figure 14-15 Calibration Curve with Excluded Samples

Review Sample Statistics
Users can review statistics for a single Results Table. Reviewing the peak integration, the calibration curve, and
the sample statistics is an iterative process.

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C108 / 169

Quantitation Analysis Workflow Tutorial



1. With a Results Table open, click the Show Statistics Table icon.

Figure 14-16 Statistics Table

2. From the Sample Grouping list, click an item to specify how the sample (for a given analyte) should be
grouped for the calculation of the statistics

3. Click the Value #1 column.

Note: The Group by Concentration for Standards and QCs are actually based on Displayed
Actual Concentration, not the Actual Concentration stored in the Results Table. If the Std 1
concentration is 0.001, Std 2 concentration is 0.005, and the display format is 0, then Std 1 and Std 2 are
grouped together because both of them are treated as 0. To group them separately, in the Column Settings
dialog, set the precision for Analyte Concentration to 0.000. If Std 1 is 0.500 and Std 2 is 0.499, then
to group them together, set the precision to 0.00. Refer to Modify the Columns Shown in the Results Table
on page 91.

4. Click an item from the Metric list to specify the actual metric that is used for the calculation of the statistics.

5. Review the Value columns. The struck out points indicate excluded data points.

Integration Algorithms
This section describes the different parameters available for each algorithm.
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About the SignalFinder Integration Algorithm

Closely Eluting Peaks

The SignalFinderTM gives a more accurate representation of the peak area of closely eluting peaks. Figure 14-17
shows an example of how the MQ4 (graph on the right) and SignalFinder (graph on the left) integration algorithms
handle closely eluting peaks. In this example, the background peak (item 2) is interfering with the peak of interest
(item1). Because the interference peak comes from either the LC or the matrix, it is fairly constant throughout the
entire batch. However, the analyte peak intensity increases as the analyte concentration increases, which results
in the combined peak shapes changing dramatically. The SignalFinder integration algorithm, based on a peak
model that is user defined, can consistently identify the peak of interest at all concentration levels while the MQ4
integration algorithm can only draw a vertical line from the valley to the baseline. This only integrates a partial
peak, which introduces errors into the peak area.

Figure 14-17 Closely Eluting Peaks

DescriptionItem

Peak of interest1

Co-eluting background peak2
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Tailing Peaks

For tailing peaks, previous algorithms are often inconsistent in selecting the retention time at which the peak
ends. Depending on the exact nature of the noise in this region, two peaks that look similar might have different
reported peak ends. The integration can usually be made more consistent by adjusting the peak-finding parameters.
However, this is at the expense of time and effort. With a modeling approach, the integration is cut off when the
model drops below a threshold, so it is much less affected by noise.

Saturated Peaks

When the algorithm detects that a peak is saturated, it uses a model to predict how the peak might look if the
detector is not saturated. This is shown as a red profile extending above the peak to approximate the response
that would have been obtained if the detector had not been saturated. This feature only corrects detector saturation
and not ion source saturation or column saturation. Figure 14-18 shows an example of saturation correction.

Before using the SignalFinderTM algorithm, select an unsaturated sample to use for building the peak model, and
then set the saturation threshold to a value that is appropriate for the detector. In this example, a saturation
threshold of 1.8E+006 cps is used. The algorithm matches the unsaturated portion of the peak that remains, the
peak below 1.8E+006 cps, to the peak model. The algorithm then predicts the rest of the peak indicated by the
red trace based on the peak model selected.

Note: The saturation threshold is dependent on a number of factors including the type of detector, the age of
the detector, and the compound of interest. For optimum results, the saturation threshold must be adjusted
appropriately.
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Figure 14-18 Detector Saturation Correction

DescriptionItem

Unsaturated portion (match peak model)1

Threshold 1.8e6 cps2

Saturated portion3

Corrected peak profile4

Peak model5

Notes on Use

Some workflows do not have a typical sample that contains all the components of interest. For example, in drug
discovery work, users might search for oxidation metabolites by adding +16 to the Q1 mass of the parent drug
and either +0 or +16 to the Q3 mass. These metabolites are usually present for some samples, but not necessarily
in the sample chosen as the model used to create the quantitation method. In this situation, the SignalFinderTM

algorithm will use a default model if, for a given MRM transition, a reasonable peak does not exist in the typical
sample. In many cases this default model will be sufficiently accurate. However, it is also possible to create a new
model during subsequent peak review using a sample that does contain the peak of interest.
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SignalFinderTM Integration Algorithm Parameters
The following parameters are used to identify and report the peak of interest. Refer to Integration Algorithm
Parameters on page 122 for a complete list of available parameters.

Use Saturation Correction

This option is only available when setting the overall algorithm default values and not during quantitation method
creation or individual peak review, because it is not useful to use this setting for only some peaks.

Saturation Threshold

Peaks above this threshold are considered saturated. This value is detector-dependent.

S/N Threshold

In Figure 14-19, if the S/N Threshold is set to seven (the graph on the left), then the peak is not reported. If the
S/N Threshold is set to two (the graph on the right), then the peak is reported. This parameter does not affect
integration.

Figure 14-19 S/N Threshold

Confidence Threshold

This parameter is used to filter potential peaks that are false positives. The default value is 50%, which is usually
suitable. However, the user might want to use a larger value for very noisy data or for data for which the peak
width has considerable variation from sample-to-sample.

Figure 14-20 and Figure 14-21 show how the Confidence Threshold affects the number of peaks identified.
When the Confidence Threshold is set to 50%, the peak with a little shoulder is identified as one peak. When
the Confidence Threshold is lowered to 16%, the SignalFinderTM algorithm finds two peaks. Drag across the
two peak regions to view the two peaks.
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To determine which other peaks are potentially present in this single peak, and if the correct Confidence
Threshold is not known, press Ctrl and then drag across the peak region of interest. This automatically lowers
the Confidence Threshold to reveal the second peak of interest that is not present when the Confidence
Threshold is set to 50%.

Figure 14-20 50% Confidence

At 16% confidence, two peaks are found. Drag across the peak area to identify the two peaks

Figure 14-21 16% Confidence
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Figure 14-22 Confidence Threshold Parameter

Use Global Baseline

Select this option to use the entire chromatogram as the baseline. If the option is not selected, then the quantitation
software assesses changes to the baseline locally. Figure 14-23 shows an example of when the local baseline
should be used.

The left graph shows a chromatogram that was properly integrated using the local baseline. The right graph shows
the same chromatogram, improperly integrated using the global baseline.

Figure 14-23 Use Global Baseline

Allow Non-Linear Baseline

Use this option to select between a linear or non-linear baseline. A non-linear baseline estimates the baseline
under each peak. The linear option fits a line between the points at the beginning and end of that specific group
of peaks. Figure 14-24 and Figure 14-25 show examples of linear and non-linear baselines for co-eluting peaks.
Items 1 to 4 are convolved peaks.
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A non-linear baseline is recommended for multiple peaks. For a single peak, the difference between linear and
non-linear is insignificant.

Figure 14-24 Example of a Linear Baseline
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Figure 14-25 Example of a Non-linear Baseline

Tips for Using the SignalFinderTM Integration Algorithm

• Merge two peaks: Occasionally, the SignalFinder integration algorithm detects two peaks. To merge the two
peaks, press Ctrl and then drag across the two peaks. The software tries to merge the peaks by reducing the
convolution sensitivity unless the two peaks are too far apart.

• Change the peak start and end times: To change the peak start and end times either while creating a Results
Table or during peak review, drag the peak start and end arrows.

Note: The user can only change the start and end arrows within reasonable limits.

MQ4 Integration Algorithm Parameters
The following parameters are used to identify and report the peak of interest. Refer to Integration Algorithm
Parameters on page 122 for a complete list of available parameters.
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Noise Percentage

This parameter is used to estimate the noise level in the chromatograms. The specified percentage of the data
points with the smallest intensity are assumed to be noise.

Typical values range from 20% to 60%. If small peaks in the presence of larger peaks are not being found, then
the noise percentage should be lowered. Figure 14-26 is an example of a small peak in the presence of an extremely
large peak. This peak is not found when the noise percentage is set to 90% but is found when the noise percentage
is set to 40%.

Figure 14-26 Peak of Interest

In Figure 14-27, the left graph shows the noise percentage set to 40%. The right graph is set to 90%.

Figure 14-27 Noise Levels
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Baseline Sub. Window

After smoothing, but before other processing, chromatograms are baseline subtracted to remove humps in the
data. For each data point, the baseline is calculated using the data points on both the left and right side of the
current point with minimum intensity (within the subtraction window).

The exact value of this parameter is not critical, provided that it is set at least a few times larger than the expected
peak width.

Figure 14-28 Baseline Subtraction Window

Peak Splitting

This parameter controls whether a potentially noisy peak is found as one single peak or as two (or more) separate
peaks. If the dip between two potential peaks is less than the specified value, then a single peak is found. Otherwise,
two peaks are found.

Setting this parameter to a large value will prevent noisy peaks from being split and found as two separate peaks.
However, a smaller value needs to be used if there are two closely eluting (overlapping) distinct peaks.

The graph on the left shows Peak Splitting set to two points. The graph on the right shows Peak Splitting set to
three points.
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Figure 14-29 Peak Splitting

Optional Tasks
This section contains optional tasks that can be used to enhance data analysis.

Create Metric Plots
Use a Metric Plot to plot the values in a Results Table column against either the row number or another
column. These plots are a valuable aid for visual data review, especially if every chromatogram does not have to
be reviewed manually using the Peak Review pane.

Note: Metric plots use the same regression formulas as the calibration curves. For metric plots there are two
additional formulas, mean and median.

1. Open a Results Table.

2. Select one or two columns and then click the Metric Plot icon. For this example, select the IS Area column.

If one column is selected, then the resulting plot displays the values from the column as a function of the row
number in the table. If two columns are selected, then the values from the columns are plotted against one
another. The first of the two columns to be selected contains the x values and the second contains the y values.

3. Right-click in the plot pane and then click Show Legend to view an explanation of the symbols used by the
plot.
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Figure 14-30 Metric Plot

Create Custom Columns

1. With a Results Table open and active, right-click and then click Add Custom Column.

A column is added to the end of the table.

2. Type the name of the column in the Custom Column Name dialog.

3. Click OK.

About Quantitation Method Files and Embedded Methods
Quantitation methods can be created using one of the following options:

• Use the Quantitation wizard.

• Edit an existing method in the Quantitation wizard with the Edit check box selected.

• Open and edit an existing quantitation method.

Quantitation methods are saved in the Quantitation Method folder.

When a Results Table is created, the quantitation method used to create the Results Table is embedded in
the Results Table. Edit the embedded quantitation method, however, any changes to the quantitation method
apply only to the Results Table embedded method and not to the methods in the Quantitation Method
folder.

Tip! This modified embedded method can be exported for future use.
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SignalFinder Integration Algorithm Parameters
The SignalFinderTM integration algorithm builds a peak model using the selected sample when creating a new
quantitation method. This model describes the shape of the selected peak used to train the algorithm.

Figure A-1 Integration Defaults Dialog
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DescriptionLabel

The selected integration algorithm.Integration Algorithm

The expected retention time in minutes. This is initially set to the retention time of the
largest peak in the chromatogram for the representative sample used to build the
quantitation method. This field is not editable. It is updated depending on the compound
in the quantitation method.

Expected RT

Half of the total retention time window in seconds. In order for a peak to be detected
and reported, the difference between the apex and the expected retention time must be
less than or equal to this value.

RT Half Window

Indicates whether the expected retention time should be adjusted on-the-fly by using
other components. Makes use of additional information to compensate for shifts in
retention time from sample-to-sample. The choices are:

• No: The expected retention time is used as is.

• Group: Applicable for components that have been assigned to groups for which all
components for a given group have the same retention time (that is, different
transitions for the same compound). The expected retention time is updated using
the position of maximum overlap of the individual chromatograms for the group (for
a given sample) within the RT window. The idea is to set the expected RT to the
probable RT for the actual component of interest (where a peak is expected in each
chromatogram.)

If there are at least two internal standards defined for a group, then only their
chromatograms are used to determine the new retention time. Otherwise, all
chromatograms for the group are used. The intention is to only use those chromatograms
for which the component is most likely to be present at a reasonable level.

• IS: For analytes using an internal standard, the actual retention time of the internal
standard peak (for the corresponding sample) is first determined. The expected RT
for the analyte is determined by multiplying the specified expected RT by the ratio of
the actual to the expected RT for the internal standard. This option is sometimes
referred to as relative retention time.

Note: This option does not apply to internal standards or to analytes that do not use
an internal standard.

Update Expected RT

If more than one peak is found in a chromatogram, then within the retention time window
and satisfying the minimum width and height, this parameter controls which peak is
reported. When the check box is selected, the peak with the largest area is reported.
When the check box is cleared, the peak with retention time closest to the expected time
is reported.

Enabling this option is recommended unless the retention times are very reproducible.

Report Largest Peak
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DescriptionLabel

This parameter does not affect integration. It is used for reporting only. Any potential
peaks that are less intense than this value are assumed to be not-of-interest and are not
used.

Min. Peak Height

When the algorithm detects that a peak is saturated, it uses the model to predict how
the peak might look if the detector is not saturated. This causes the profile to extend
above the top of the peak to approximate the response that would have been obtained
if the detector had not saturated. This can extend the linear dynamic range of calibration
curves. This option is only available when setting the overall algorithm default values
and not during quantitation method creation or individual peak review, because it is not
useful to use this setting for only some peaks.

Use Saturation
Correction

Peaks above this threshold are considered saturated. This value is detector-dependent.Saturation Threshold

This parameter does not affect integration. It is used for reporting only. Peaks that are
below the threshold are not reported.

S/N Threshold

Used to filter potential peaks that are false positives. The default value is 50%, which is
usually suitable. However, a larger value can be used for very noisy data or for data for
which the peak width has considerable variation from sample-to-sample.

Confidence Threshold

Select to use the entire chromatogram as the baseline. If the check box is not selected,
then the software assesses changes to the baseline locally.

Use Global Baseline

Select between a linear or non-linear baseline. A non-linear baseline estimates the baseline
under each peak. A linear baseline fits a line between the points at the beginning and
end of that specific group of peaks.

Allow Non-Linear
Baseline
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MQ4 Integration Algorithm Parameters

Figure A-2 Integration Defaults Dialog

DescriptionLabel

The selected integration algorithm.Integration Algorithm

A standard Gaussian smoothing algorithm with a half-width equal to the specified
value (in points) is applied. For noisy chromatograms, a value close to the actual
peak width (at half height) is a good choice. For less noisy data, a smaller value can
be used.

Gaussian Smoothing Width

The expected retention time, in minutes. This is initially set to the retention time of
the largest peak in the chromatogram for the representative sample used to build
the quantitation method.

Expected RT

Half of the total retention time window in seconds. In order for a peak to be detected
and reported, the difference between the apex and the expected retention time must
be less than or equal to this value.

RT Half Window
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DescriptionLabel

Indicates whether the expected retention time should be adjusted on-the-fly by using
other components. Makes use of additional information to compensate for shifts in
retention time from sample-to-sample. The choices are:

• No: The expected retention time is used as is.

• Group: Applicable for components that have been assigned to groups for which
all components for a given group have the same retention time (that is, different
transitions for the same compound). The expected retention time is updated
using the position of maximum overlap of the individual chromatograms for the
group (for a given sample) within the RT window. The idea is to set the expected
RT to the probable RT for the actual component of interest (where a peak is
expected in each chromatogram.)

If there are at least two internal standards defined for a group, then only their
chromatograms are used to determine the new retention time. Otherwise, all
chromatograms for the group are used. The intention is to only use those
chromatograms for which the component is most likely to be present at a reasonable
level.

• IS: For analytes using an internal standard, the actual retention time of the
internal standard peak (for the corresponding sample) is first determined. The
expected RT for the analyte is determined by multiplying the specified expected
RT by the ratio of the actual to the expected RT for the internal standard. This
option is sometimes referred to as relative retention time.

Update Expected RT

If more than one peak is found in a chromatogram, within the retention time window
and satisfying the minimum width and height, then this parameter controls which
peak is reported. When the check box is selected, the peak with the largest area is
reported. When the check box is cleared, then the peak with retention time closest
to the expected time is reported.

Enabling this option is recommended unless the retention times are very reproducible.

Report Largest Peak

This parameter does not affect integration. It is used for reporting only. Any potential
peaks that are less intense than this value are assumed to be not-of-interest and are
not used.

Min. Peak Height

Any potential peaks that are narrower than this value are assumed to be noise and
are not used.

Min. Peak Width

This parameter is used to estimate the noise level in the chromatograms. The specified
percentage of the data points with the smallest intensity are assumed to be noise.

Typical values range from 20% to 60%. If small peaks in the presence of larger peaks
are not being found, then this value should be lowered.

Noise Percentage
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DescriptionLabel

After smoothing, but before other processing, chromatograms are baseline subtracted
to remove humps in the data. For each data point, the baseline is calculated using
the data points on both the left and right side of the current point with minimum
intensity (within the subtraction window).

The exact value of this parameter is not critical, provided that it is set at least a few
times larger than the expected peak width.

Baseline Sub. Window

This parameter controls whether a potentially noisy peak is found as one single peak
or as two (or more) separate peaks. If the dip between two potential peaks is less
than the specified value, then a single peak is found. Otherwise, two peaks are
found.

Setting this parameter to a large value prevents noisy peaks from being split and
found as two separate peaks. However, a smaller value needs to be used if there
are two closely eluting (overlapping) distinct peaks.

Peak Splitting
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This section describes the equations used to calculate the regression curves. In the following equations, x represents
the analyte concentration for Standard samples and y represents the corresponding peak area or height. The
exact variables used for the regression depend on whether an internal standard is being used and whether the
peak area or the peak height is used as shown in Table B-1.

Table B-1 Regression Variables

yxArea Used?Internal
Standard Used?

Aa / AisCa / Cis / DFYesYes

Ha / HisCa / Cis / DFNoYes

AaCa/ DFYesNo

HaCa/ DFNoNo

where:

• Ca = actual analyte concentration

• Cis = internal standard concentration

• DF = dilution factor

• Aa = analyte peak area

• Ais = internal standard peak area

• Ha = analyte peak height

• His = internal standard peak height
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Weighting Factors
Table B-2 shows how the weighting factor (w in the equations) is calculated for each of the seven weighting types.

Table B-2 Weighting Factors

Weight (w)Weighting Type

Always 1.0.None

If |x| < 10-5, then w = 105. Otherwise, w = 1 / |x|.1 / x

If |x| < 10-5, then w = 1010. Otherwise, w = 1 / x2.1 / x2

If |y| < 10-8, then w = 108. Otherwise, w = 1 / |y|.1 / y

If |y| < 10-8, then w = 1016. Otherwise, w = 1 / y2.1 / y2

If x < 0, then an error is generated. If x < 10-5, then w = ln 105. Otherwise, w =
|ln x|.

ln x

If y < 0, then an error is generated. If y < 10-8, then w = ln 108. Otherwise, w =
|ln y|.

ln y

Regressions
This section provides the equations for each of the regression types. In the following equations, x, y, and w are
as defined previously. All sums are calculated over all Standard samples, with the exception of those Standard
samples that are marked as not used.

The correlation co-efficient is calculated as:

where:

yc = Calculated y-value using the appropriate equation below
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Linear
The linear calibration equation is:

y = mx + b

The slope and intercept are calculated as:

where:

Linear Through Zero
The linear through zero calibration equation is:

y = mx

The slope is calculated as:

Mean Response Factor
The mean response factor calibration is:

y = mx

This is the same equation as for the linear though zero case. However, the slope is calculated differently as:

and the standard deviation of the response factor as:

where:

Note: Points whose x value is zero are excluded from the sums.

If there is some linearity and some curvature in the line of points, then use power regression instead of linear or
quadratic regression to produce a line somewhere between these fits.
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Quadratic
The quadratic calibration equation is:

y = a2x2 + a1x + a0

The polynomial co-efficients are calculated as:

a2 = (b2/b0 - b5/b3) / (b1/b0 - b4/b3)

a1 = b5/b3 - a2b4/b3

where:

Power
The power function calibration equation is:

y = axp

The equations for the linear calibration are used as described above to calculate the slope (m) and intercept (b),
except that x in those equations is replaced by ln x and y is replaced by ln y. When this is done, a and p are
calculated as:

a = eb

p = m

If any of the x or y values are negative or zero, then an error is reported.

Wagner
The Wagner calibration equation is:

ln y = a2 (ln x)2 + a1 (ln x) + a0
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The equations for the quadratic calibration are used as described above to calculate a0, a1, and a2, except that x
in those equations is replaced by ln x and y is replaced by ln y.

If any of the x or y values are negative or zero, then an error is reported.

Hill
The Hill calibration equation is:

y = (a + bxn) / (c + xn)

It is not possible to provide an analytical function for solving for a, b, c, and n. Instead, the co-efficients are
determined using the iterative Levenberg-Marquardt method.

Calculating Final Concentrations
This section explains how to calculate the final concentration from the resultant regression equations, using the
IS concentration and dilution factor used in the original concentration.

Linear
x = (y – b) / m

Linear Through Zero and Mean Response Factor
x = y / m

Quadratic
x = (–a1 ± (a1

2 – 4 × a2 × (a0 – y)) 0.5) / (2 × a2)

• If both the + and – roots are within the range of the standards, then an error is generated since there is no
unique solution.

• If exactly one of the two roots is within the concentration range of the standards, then that value is reported.

• If both roots are below the lowest concentration standard, then the + root is reported.

• If both roots are above the highest concentration standard, then the – root is reported.

• If the – root is below the lowest standard and the + root is above the highest standard, then the – root is
reported if the difference from the lowest concentration standard is less than the difference of the + root from
the highest concentration. Otherwise, the + root is reported.

Power
x = (y / a)(1 / p)
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Wagner
The same equation for the quadratic case is used for the main calculation, except that x is replaced by ln x and y
is replaced by ln y.

Hill
x = ((a – y × c) / (y – b)) (1 / n)
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This section describes how to use the report functionality in the software to create formatted reports from Results
Tables.

Create Reports
This software uses Microsoft Word documents as predefined templates. When a report is created, values are
extracted from the most current Results Table and associated files.

Users are responsible for validating custom templates. The user can edit the number format in the report template
editor. If the number format is not specified in the template, then the format in the Results Table Column
Setting is used in the report. Make sure that the correct number of decimal places are used.

The controlled ways to output data from the software are exporting Results Tables, transferring to LIMS, and
reporting. The other sources of output data such as copying and pasting from Results Tables are not controlled.
Users should not use those uncontrolled output methods for regulated purposes.

Browse to any folder to access and store data. The previous locations that templates were opened from and reports
saved to are opened by default.

1. Open a Results Table.

2. Click File > Create Report and Save Results Table.

Figure C-1 Create Report Dialog
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DescriptionItem

Report template: Select a template from the list..1

Open in Word: Click to open the specified report template directly in Microsoft Word to verify
or edit it.

2

Generated report file: Shows the name of the report file.3

Set: Click to specify the filename of the report to generate.4

Generate all images in black and white: Select the check box to print in black and white.5

Output Format: Word, HTML, PDF, or CSV. PDF is the most secure method of output because
the report cannot be edited.

6

Create an individual report for each sample (Recommended for large reports)7

Click OK to print the report.8

Click Cancel to close the dialog without creating a report.9

3. Select a template from the Report template list. The report templates are stored in the following locations:

• For Windows 7 and 10: C:\ProgramData\AB SCIEX\MultiQuant\Reporter.

Refer to Report Templates on page 137 for a description of the templates.

4. Click Set to create the name and location of the report.

5. Click OK to generate the report.

Create Custom Report Templates
The controlled ways to output data from the software are exporting Results Tables, transferring to LIMS, and
reporting. The other sources of output data such as copying and pasting from Results Tables are not controlled.
Users should not use those uncontrolled output methods for regulated purposes.

1. Open or create a Results Table.

2. Click File > Create Report and Save Results Table.
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Figure C-2 Create Report Dialog

DescriptionItem

Report template: Select a template from the list..1

Open in Word: Click to open the specified report template directly in Microsoft Word to verify
or edit it.

2

Generated report file: Shows the name of the report file.3

Set: Click to specify the filename of the report to generate.4

Generate all images in black and white: Select the check box to print in black and white.5

Output Format: Word, HTML, PDF, or CSV. PDF is the most secure method of output because
the report cannot be edited.

6

Create an individual report for each sample (Recommended for large reports)7

Click OK to print the report.8

Click Cancel to close the dialog without creating a report.9

3. Select a template from the Report template list.

4. Click Open in Word.

The docx template opens and the Reporter template editor is shown on the right. The template editor is
automatically populated with the tag information.

5. Edit the template as required.

6. Save the template.
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Report Templates
The following table describes the available templates found in <drive>:\ProgramData\AB SCIEX\MultiQuant\Reporter.

In the event of creating a custom template, the user is responsible for validating the template. The user can edit
the number format in the Report Template editor. If the number format is not specified in the template, the format
in the Results Table Column Settings dialog will be used in the report. It is the responsibility of the user to
validate the custom report template.

Some report templates use queries. Users can create queries using Microsoft Excel-based formulae to evaluate,
manipulate, and present the data from the Results Table in a report. The Metafield tag in the report template tells
the report the name of the query file that it should use. To use queries, the name of the query file must be specified
in the MetaField tag in the report template. Queries must also have the extension ".query" to be recognized as a
query. The queries must be stored in the Reporter folder where the report templates are stored.

We recommend that the user validate the generated results when a Reporter template is used, especially when
queries are used in a template. If any modifications are made to the report template after validation, then the
report template should be re-validated. Changes to the report template include any modification to reporter tags
or queries.

Table C-1 Report Template Descriptions

DescriptionTemplate

Secure report showing a Samples Summary Table for each analyte. This report template
is suitable for a Results Table with defined groups.

Analyte Report Summary

Report showing File Information, Statistics Table (standards) and Calibration Curve
for analytes, one page per analyte.

Calibration Curves
Template

Secure report showing, for each internal standard, a section including File Information
and metric plot of IS peak area.

Metric Plot_IS Area

Secure report showing, for each analyte, a section including File Information, Results
Table, Calibration Curves for each analyte, and chromatograms including IS and each
analyte. This template is suitable for a Results Table with defined groups.

Per Analyte Ion Ratio
Report

Secure report showing, for each analyte, a section including File Information, Results
Table, Calibration Curves for each analyte, and chromatograms including IS and each
analyte. This template is suitable for a Results Table with no defined groups.

Per Analyte Report

Secure report showing, for each sample, a section including File Information, Sample
Information, Analyte Results Table, Calibration Curves for each analyte, and
chromatograms including IS and each analyte. This template is suitable for a Results
Table with defined groups.

Per Sample Ion Ratio
Report
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Table C-1 Report Template Descriptions (continued)

DescriptionTemplate

Secure report showing, for each sample, a section including File Information, Sample
Information, Analyte Results Table, Calibration Curves for each analyte, and
chromatograms including IS and each analyte. This template is suitable for a Results
Table with no defined groups.

Per Sample Report

Secure report showing an Analytes Summary Table for each sample. This report
template is suitable for a Results Table with defined groups.

Sample Report Summary

Report showing File Information, Sample Information, and Results Summary Table for
each unknown sample. The Results Summary Table includes analyte-specific
concentration thresholds. Analytes are flagged as positive if the concentration is above
the threshold. This template references the Sample Report With Concentration
Threshold.query file. The user can edit the query file to specify the analyte names,
analyte groups (for example, compound class), and analyte concentration thresholds.

Sample Report with
Concentration
Threshold.docx

Report Template Tags

Table C-2 Report Template Tags

Tag DescriptionField TypeType

Tags from the Analyst
®
 MD software data provider schema

Loops over all the analytes, in the order they are
defined in the Results Table.

ForEachAnalyte

Loops over the various analyte groups only.
TextField or PictureField tags retrieve values for
the Quantifier ion. If tags of this type contain an
additional For_Each tag specifying the RatioIons
attribute, then the inner loop is only for Qualifier
ions that are part of the current group.

ForEachAnalyteGroup

Loops over all internal standards.ForEachInternalStandard

Loops over all Quality Control statistics.ForEachQCStatistics

Refer to AnalyteGroup.ForEachRatioIons

Loops over each of the individual samples. This is
used, for example, in conjunction with a TextField
tag setup to insert the Sample Name.

ForEachSample
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

Loops over all Standards statistics.ForEachStatistics

Loops over the various groups, including IS groups
or subgroups. TextField or PictureField tags retrieve
values for the Quantifier ion. If tags of this type
contain an additional For_Each tag specifying the
RationIons attribute, then the inner loop is only
for Qualifier ions that are part of the current group.

ForEachMQ_Group

Refer to MQ_Group for Analyte qualifier only.ForEachMQ_AnalyteRatioIons

Refer to MQ_Group for IS qualifier only.ForEachMQ_ISRatioIons

Shows the overlays of chromatograms of
Quantifier and Qualifier of the analyte subgroup.
Shows the solid line in the middle to indicate the
Expected Ion Ratio. The middle line = the peak
height of the Quantifier x Expected Ion ratio.
Shows the lower and upper bounds of the
acceptable Ion Ratio range with dotted lines.
Lower Bound = Peak Height of Quantifier x
Expected Ion Ratio x ((100-tolerance)/100). Upper
Bound = Peak Height of Quantifier x Expected Ion
Ratio x ((100+tolerance)/100).

PictureFieldAnalyteRatio

Shows the overlays of chromatograms of
Quantifier and Qualifier of analyte subgroup
without the lines.

PictureFieldAnalyteRatioNoLines

Shows the calibration curve of the analyte.PictureFieldCalibration

Shows the overlays of chromatograms of
Quantifier and Qualifier of internal standard
subgroup. Shows the solid line in the middle to
indicate the Expected Ion Ratio. The middle line
= the peak height of the Quantifier x Expected Ion
ratio. Shows the lower and upper bounds of the
acceptable Ion Ratio range with dot lines. Lower
Bound = Peak Height of Quantifier x Expected Ion
Ratio x ((100-tolerance)/100) Upper Bound = Peak
Height of Quantifier x Expected Ion Ratio x
((100+tolerance)/100)

PictureFieldIS_AnalyteRatio
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

Shows the overlays of chromatograms of
Quantifier and Qualifier of internal standard
subgroup without the lines.

PictureFieldIS_AnalyteRatioNoLines

Shows the chromatogram of the internal standard.PictureFieldIS_PeakReview

Shows the overlay of the chromatograms of all the
analytes in the sample.

PictureFieldOverlay_All_XIC

Shows the overlay of the chromatograms of all the
analytes and internal standards in the sample.

PictureFieldOverlay_All_XIC_with_IntStds

Shows the overlay of the chromatograms of all the
analytes and internal standards in the sample,
without the legend.

PictureFieldOverlay_All_XIC_with_IntStds_NoLegend

Shows the overlay of the chromatograms of all the
analytes in the sample, without the legend.

PictureFieldOverlay_All_XIC_NoLegend

Shows the chromatogram of the analyte.PictureFieldPeakReview

Shows the TIC of the sample.PictureFieldTIC

The date on which the sample was acquired.

Shows the "Acquisition Date & Time".

TextFieldAcquisition_Date

Shows the time period of data acquired of the
sample, reported in minutes.

TextFieldAcquisition_Duration_Minutes

The acquisition method that was used to acquired
the sample data.

Shows the "Acq. Method Name".

TextFieldAcquisition_Method

Shows the "Component Comment".TextFieldAnalyte_AnalyteAnnotation

Shows the R value of regression.TextFieldAnalyte_AnalyteCorrelation

Shows the regression equation, including the R
value and weighting.

TextFieldAnalyte_AnalyteRegression

The actual concentration of the analyte, as defined
by the user in the Results Table.

Shows the "Actual Concentration".

TextFieldAnalyte_Concentration
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

The expected retention time for a specific analyte,
in minutes.

Shows the "Expected RT".

TextFieldAnalyte_Expected_RT

The type of integration used for specific analyte
peaks. Peaks can be manually integrated or can
be integrated using the available parameters.

Shows the "Integration Type".

TextFieldAnalyte_Integration_Type

The ratio of the area of the analyte peak to the
area of the peak from an internal standard
solution. Calculated as Analyte Peak Area / IS Peak
Area.

Shows the "Area Ratio".

TextFieldAnalyte_IS_Area_Ratio

The ratio of the height in counts per second (cps)
of the analyte peak to the height of the peak from
an internal standard solution. Calculated as
Analyte Peak Height / IS Peak Height.

Shows the "Height Ratio".

TextFieldAnalyte_IS_Height_Ratio

The user-defined MRM transition for an analyte,
defined in the acquisition method used.

Shows the "Mass Info".

TextFieldAnalyte_Mass_Ranges

The peak area for an analyte in a chromatogram.

Shows the "Area".

TextFieldAnalyte_Peak_Area

The height for the analyte peak, in counts per
second (cps).

Shows the "Height".

TextFieldAnalyte_Peak_Height

The user-defined name assigned to specific
samples when creating the Results Table.

Shows the "Component Name".

TextFieldAnalyte_Peak_Name

The width of an analyte peak, in minutes.

Shows the "Total Width".

TextFieldAnalyte_Peak_Width
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

The width at 50% of the peak height for an analyte
peak, in minutes.

Shows the "Width at 50%".

TextFieldAnalyte_Peak_Width_at_50%_Height

Shows the integration information including
algorithm and parameters.

TextFieldAnalyteQuantPeak_info

The Analyte Quantity, calculated from the analyte
calculated concentration and weight-to-volume
ratio (for example, ng of analyte per gram of
sample).

Shows the "Quality".

TextFieldAnalyte_QTY

Is the first analyte in the group.TextFieldisCurrentAnalyteQuantifier

Shows the integration algorithm.TextFieldAnalyte_Processing_Alg

The actual retention time for an analyte in a
chromatogram used to generate a Results Table.

Shows the "Retention Time".

TextFieldAnalyte_Retention_Time

Shows the R 2 value of regression.TextFieldAnalyte_R_Squared

The range of time, in seconds, in which an analyte
peak is expected to appear. The center of this
range is the expected retention time for the
analyte.

Shows the value of "RT Half Window" of the
integration parameters.

TextFieldAnalyte_RT_Window

The signal-to-noise ratio for a specific analyte
peak.

Shows the "Signal/Noise".

TextFieldAnalyte_Signal_To_Noise

The slope of the baseline for an analyte, taken in
terms of % Intensity/minutes.

Shows the "Slope of Baseline" for the analyte.

TextFieldAnalyte_Slope_of_Baseline

Analyte Start Scan.TextFieldAnalyte_Start_Scan

The time where the analyte peak begins, in
minutes.

Shows the "Start Time".

TextFieldAnalyte_Start_Time
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

Analyte Stop Scan.TextFieldAnalyte_Stop_Scan

The time where the analyte peak ends, in minutes.

Shows the "End Time".

TextFieldAnalyte_Stop_Time

The units used to represent the concentration for
analytes. The standard unit for Results Tables is
ng/mL.

Shows the "Conc. Units".

TextFieldAnalyte_Unit

A selection box which determines whether a
specified record will be used for subsequent
analysis such as calibration curves.

Shows the "Used".

TextFieldAnalyte_Use_Record

Shows the total number of analytes.TextFieldAnalyte_Count

Shows the order number of the analyte in sample,
starting from 0.

TextFieldAnalyte_Index

The accuracy for the analyte peak, derived by
comparing the actual analyte concentration to the
calculated analyte concentration.

Shows the "Accuracy".

TextFieldCalculated_Accuracy

The calculated concentration for the analyte peak
performed by the Analyst

®
 MD software using the

peak area.

Shows the "Calculated Concentration".

TextFieldCalculated_Concentration

The retention time for an analyte or internal
standard specific record in a Results Table.

Shows the "Relative RT".

TextFieldCalculated_Relative_Retention_Time

The actual concentration of an internal standard,
as defined by the user in the Results Table.

Shows the "IS Actual Concentration".

TextFieldIS_Concentration

The expected retention time of an internal
standard peak, in minutes.

Shows the "IS Expected RT".

TextFieldIS_Expected_RT

MultiQuantTM MD 3.0.3 SoftwareReference Guide
143 / 169IVD-IDV-06-0904-C

Reports



Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

The type of integration used for specific internal
standard peaks. Peaks can be manually integrated
or can be integrated using the available
parameters.

Shows the "IS Integration Type".

TextFieldIS_Integration_Type

The user-defined MRM transition for an internal
standard, defined in the acquisition method used.

Shows the "IS Mass Info".

TextFieldIS_Mass_Ranges

The peak area for an internal standard.

Shows the "IS Area".

TextFieldIS_Peak_Area

The height for the internal standard peak, in
counts per second (cps).

Shows the "IS Height".

TextFieldIS_Peak_Height

The user-defined name given to a specific internal
standard, when creating the Results Table.

Shows the "IS Name".

TextFieldIS_Peak_Name

The width of an analyte peak, in minutes.

Shows the "IS Total Width".

TextFieldIS_Peak_Width

The peak width, in minutes, for an internal
standard peak at half of its height, in counts per
second (cps).

Shows the "IS Width at 50%".

TextFieldIS_Peak_Width_at_50%_Height

The actual retention time for an internal standard.

Shows the "IS Retention Time".

TextFieldIS_Retention_Time

The range of time, in seconds, in which an internal
standard peak is expected to appear. The center
of this range is the expected retention time for the
internal standard.

Shows the value of "RT Half Window" of the
integration parameters for IS.

TextFieldIS_RT_Window

Shows the integration information including
algorithm and parameters.

TextFieldISQuantPeak_Info
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

The signal-to-noise ratio of an internal standard
peak.

Shows the "IS Signal/Noise".

TextFieldIS_Signal_To_Noise

The slope of the baseline for an internal standard,
taken in terms of % Intensity/minutes.

Shows the "Slope of Baseline" for the Internal
Standard.

TextFieldIS_Slope_of_Baseline

Internal Standard Start Scan.TextFieldIS_Start_Scan

The time where the internal standard peak begins,
in minutes.

Shows the "IS Start Time".

TextFieldIS_Start_Time

Internal Standard Stop Time.TextFieldIS_Stop_Scan

The time where the internal standard peak ends,
in minutes.

Shows the "IS End Time".

TextFieldIS_Stop_Time

The units used to represent the concentration for
internal standards. The standard unit for Results
Tables is ng/mL.

Shows the "Conc. Units" for IS.

TextFieldIS_Units

Shows the value of the Max. Accuracy Tolerance
for LLOQ in the Outlier Setting dialog of the
Quantitation Method.

TextFieldMQ_Accuracy_Tolerance_LLOQ

Shows the value of the Max. Accuracy Tolerance
for Standards in the Outlier Setting dialog of the
Quantitation Method.

TextFieldMQ_Accuracy_Tolerance_STD

Shows the value of the Max. Accuracy Tolerance
for QCs in the Outlier Setting dialog of the
Quantitation Method.

TextFieldMQ_Accuracy_Tolerance_QC

Shows the name of the analyte group name.TextFieldMQ_Analyte_Group_Name

Shows the name of the product that is used to
generate the report.

TextFieldMQ_Created_With

Shows the "Expected Ion Ratio".TextFieldMQ_Expected_Ion_Ratio
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

Shows the order number of the group in sample,
starting from 1. Use with ForEach MQ_Group loop.

TextFieldMQ_Group_Index

Shows the name of the group. Use with ForEach
MQ_Group loop.

TextFieldMQ_Group_Name

Shows the "Ion Ratio".TextFieldMQ_Ion_Ratio

Shows the value of the Max. Ion Ratio Tolerance
for the analyte in the Outlier Setting dialog of the
Quantitation Method.

TextFieldMQ_IonRatio_Tolerance

Shows the name of the internal standard group.TextFieldMQ_IS_Group_Name

Shows the row hidden in Results Table.TextFieldMQ_IsRowHidden

Shows the value of the Lower Limit of Calculated
Concentration in the Outlier Setting dialog of the
Quantitation Method.

TextFieldMQ_Lower_Limit_Concentration

Shows the "Outlier Reasons".TextFieldMQ_Outlier_Reasons

Shows the "Asymmetry Factor".TextFieldMQ_Peak_Asymmetry_Factor

Shows the "Baseline Delta/Height".TextFieldMQ_Peak_BaselineDelta_to_Height

Shows the "End Time at 10%".TextFieldMQ_Peak_End_at_10pct

Shows the "End Time at 5%".TextFieldMQ_Peak_End_at_5pct

Shows the "Points Across Baseline".TextFieldMQ_Peak_Points_Across_Baseline

Shows the "Points Across Half Height".TextFieldMQ_Peak_Points_Across_Half_Height

Shows the "Start Time at 10%".TextFieldMQ_Peak_Start_at_10pct

Shows the "Start Time at 5%".TextFieldMQ_Peak_Start_at_5pct

Shows the "Tailing Factor".TextFieldMQ_Peak_Tailing_Factor

Shows the "Width at 10%".TextFieldMQ_Peak_Width_at_10pct

Shows the "Width at 5%".TextFieldMQ_Peak_Width_at_5pct

Shows the "Mass Range" for the quantifier in the
analyte group.

TextFieldMQ_Quantifier_Mass_Ranges

Shows the "Area" for the quantifier in the analyte
group.

TextFieldMQ_Quantifier_Peak_Area
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

Shows the "Calculated Concentration" for the
quantifier in the analyte group.

TextFieldMQ_Quantifier_Calculated_Concentration

Shows the date of the report generation, reflecting
the culture settings from the software.

TextFieldMQ_Report_Generation_Date

Shows the value of the Upper Limit of Calculated
Concentration in the Outlier Setting dialog of the
Quantitation Method.

TextFieldMQ_Upper_Limit_Concentration

The name of the query referenced in the report
template (if applicable).

TextFieldQuery_Name

Shows the "Modified".TextFieldRecord_Modified

The name of the report template used to create
the report.

TextFieldReporter_Template_Name

Shows the date the Results Table was created.TextFieldResultTbl_CreateDate

Shows the processing algorithm used to process
the Results Table (for example, MQ4,
SignalFinder1).

TextFieldResultTbl_IntegrAlgorithm

Shows the filename for the Results Table.TextFieldResultTbl_Name

Shows the project name in which the Results Table
saved.

TextFieldResultTbl_ProjName

A comment related to the sample.

Shows the "Sample Comment".

TextFieldSample_Comment

The total number of unit volumes in which the
sample is dissolved.

Shows the "Dilution Factor".

TextFieldSample_Dilution_Factor

The name of the data file where the raw data for
the specific sample is stored.

Shows the "Original Filename".

TextFieldSample_File_Name

A user-defined value for listing specific IDs for each
sample or analyte in the Results Table.

Shows the "Sample ID".

TextFieldSample_ID

Shows the "Index".TextFieldSample_Index
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

Shows the the total number of analytes.TextFieldSample_Count

The injection volume used in the autosampler used
when the original sample was injected, as defined
in the acquisition method.

Shows the "Injection Volume".

TextFieldSample_InjectionVolume

Shows the type of instrument used to acquire the
sample, which is extracted from the wiff file.

TextFieldSample_Instrument

Shows the serial number of the instrument used
to acquire the sample, which is extracted from the
wiff file.

TextFieldSample_InstrumentSerialNumber

The user-defined name assigned to the specific
sample when creating the Results Table.

Shows the "Sample Name".

TextFieldSample_Name

The logged in user at the time of the acquisition.

Shows the "Operator Name".

TextFieldSample_Operator

The position of the sample plate in the
autosampler used when acquiring the samples.

Shows the "Plate Number".

TextFieldSample_Plate_Number

The position of the sample rack in the autosampler
used when acquiring the samples.

Shows the "Rack Number".

TextFieldSample_Rack_Number

The user-defined value indicating what type of
sample each specific injection is from. For example,
Blank, Standard, and so on.

Shows the "Sample Type".

TextFieldSample_Type

The vial position defined in the acquisition batch
used in the autosampler to determine which vial
holds the sample.

Shows the "Vial Number".

TextFieldSample_Vial_Position

Shows the file name with the full path.TextFieldSample_File_Full_Name

Shows the order number of the sample in the wiff
file, starting from 0.

TextFieldSample_Index_In_Wiff
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

The accuracy for the analyte peak, determined by
comparing the actual analyte concentration to the
calculated analyte concentration.

Shows the "Accuracy".

TextFieldSta_Accuracy

Shows the conditional variance percent that
dictates how close or far in terms of percent a
calculated concentration value deviates from the
mean concentration value. Calculated by taking
standard deviation/mean.

TextFieldSta_CV

The expected concentration for an analyte
calculated by the Analyst

®
 MD software, using the

peak area.

Shows the "Actual Concentration".

TextFieldSta_ExpectedConcent

Shows the mean value (average) for the calculated
concentrations that are calculated by the Analyst

®

MD software.

TextFieldSta_Mean

Shows the number of values that make the
statistic. How many samples are taken into
account when an average is performed.

TextFieldSta_NumVal

The accuracy determined by comparing the
expected concentration to the actual concentration
for a quality control sample as defined by the user
in the sample type column.

Shows the "Accuracy".

TextFieldSta_QCAccuracy

Shows the conditional variance percent that
dictates how close or far in terms of percent a
calculated concentration value deviates from the
mean concentration value. Calculated by taking
standard deviation/mean. Applies to a Quality
Control sample.

TextFieldSta_QCCV

The expected concentration for a Quality Control
sample, as defined by the user.

Shows the "Actual Concentration" for the Quality
Control sample.

TextFieldSta_QCExpectedConcent
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Table C-2 Report Template Tags (continued)

Tag DescriptionField TypeType

Shows the mean value (average) for the calculated
concentrations that are calculated by the Analyst

®

MD software for a Quality Control sample.

TextFieldSta_QCMean

Shows the number of values taken into account
for a quality control sample concentration mean
when performing the average.

TextFieldSta_QCNumVal

Shows the standard deviation for the concentration
values for each sample. The standard deviation
represents a measure of the spread of a set of
values from the mean value.

TextFieldSta_QCStdDev

Shows the standard deviation for a standard
sample. The standard deviation represents a
measure of the spread of a set of values from the
mean value.

TextFieldSta_StdDev

Shows the value of Results Table custom columns.TextFieldCUSTOM

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C150 / 169

Reports



When performing quantitative mass spectrometry data processing, it is important to determine whether a given
peak is significant or not, where 'significant' typically means 'does this signal exceed background noise?'

Usually the peak height is compared to background noise measured in a peak-free region where the noise is
typically estimated as either one or three times the standard deviation of the data points in this range. This approach
is less than ideal for the following reasons:

• It is subjective, as the noise region is selected manually.

• A background region without a peak might not exist or the region might be too narrow for an accurate estimate
of the noise.

• The noise at the peak position might be quite different from that in the selected noise region.

• The factor of ‘one or three’ is also subjective and different authorities have different recommendations.

• The apparent noise can be altered if the data have been pre-processed. For example, smoothed, or thresholded.

By using the concept of Relative Noise (Rn), it is easy to develop a simple method to calculate the expected noise
at any point in the data, to compare against the measured signal. This is a robust, objective metric that can be
used to calculate signal-to-noise (S/N) and to evaluate and compare instrument and assay performance. There are
many applications of the relative noise concept, one of which is the calculation of S/N.

The basic algorithm works as follows:

1. Devise a noise model that will allow the user to calculate the expected noise at any point in the data record,
given the level of the underlying signal at that point.

The noise model can be determined from theoretical considerations or can be modeled from real measurements
for a particular system. For pulse counting detectors, the standard deviation of a signal, and therefore the
expected noise, is proportional to the square root of the signal and therefore varies with the signal. In other
systems there will be a constant ‘white noise’ component, possibly combined with an intensity-dependent
component.
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2. Estimate the underlying signal from the measured signal.

This can be achieved in many ways, but the simplest is to generate a smoothed version of the data as shown
in Figure D-1.

Figure D-1 Overlay of Raw and Smoothed Data

3. Measure the actual noise across the data using all points (peaks and background).
This is achieved by subtracting the underlying signal estimate from the measured signal at each point in the
data where the smoothed signal has been subtracted from the original. This is known as the delta noise. The
range of the delta noise is reasonably constant, except where there are large peaks because the noise is
dependent on the signal and therefore greater where the signal is larger. Refer to Figure D-2.

Figure D-2 Plot of the Delta Noise Values of Each Data Point

Reference GuideMultiQuantTM MD 3.0.3 Software
IVD-IDV-06-0904-C152 / 169

Relative Noise and Signal-to-Noise Calculations



4. At each data point, calculate the ratio of the measured noise to the expected noise.

That is, at every data point we divide the noise we measured in step 3 by the value our noise model predicts
(in our case the square root of the intensity). If the noise model is good, then generates a series of values that
mostly remain bounded by some limits as shown Figure D-3. Figure D-3 also shows the plot of

Note: This reduces the large variation in the delta noise and results in a well constrained set of values.

Figure D-3 Noise Model
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5. Calculate the standard deviation of the ratio values. This is the Rn, an estimate of the most likely relationship
between the actual delta noise and that predicted by the model. In Figure D-3, this results in a value of 9.5.

Figure D-4 shows an example of how relative noise can be used to calculate S/N.

Figure D-4 Overlay of Raw Data, Underlying Signal Estimates, and Baseline Estimates

As described previously:

in this particular example:

If the apex of the peak is used as the signal, then this gives a S/N of 34 (4900/145) and if the height of the smoothed
signal is used, then this gives a S/N of 22 (3150/145).

When reporting the S/N, the MQ4 integration algorithm uses the procedure described here and the peak apex as
the signal. Because the SignalFinderTM integration algorithm is fitting a model to the peak, it uses the height of
the fitted profile. This results in a smaller reported S/N. However, it is a more accurate value because it is less
affected by possible noise spikes. The SignalFinder integration algorithm also has a more sophisticated approach
to baseline estimation, so for these two reasons, the S/N values reported by the two algorithms are not identical
although they will usually be similar.

In summary, compared to the usual approach of estimating the noise as the standard deviation of a background
region, the relative noise approach to calculating S/N has the following advantages:

• It is much less subjective because a background region does not need to be selected manually.

• An accurate S/N can be predicted even if no peak-free regions of the chromatogram exists.
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• The baseline and therefore the noise is estimated near the peak of interest. This can make a large difference
to the reported S/N value because the background region selected for the usual approach might be much
quieter than the background near the peak. As described previously, the S/N calculated using the Relative
Noise approach might give smaller values than the usual approach. However, they are more accurate and
useful values. Refer to Figure D-4.

To make the Signal / Noise column visible in the Results Table, refer Modify the Columns Shown in the
Results Table on page 91.

Note on Signal-to-Noise when Using the
SignalFinder Integration Algorithm
Because the SignalFinderTM integration algorithm calculates signal-to-noise more accurately (and thefore more
accurately predicts CVs), if the 1-sigma signal-to-noise approach is used, then consider decreasing the minimum
acceptable signal-to-noise value on any standard operating procedures (SOPs), based on empirical data from the
laboratory.
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Only one pane is active at a time. Active panes have an orange border and the user can activate a pane by clicking
anywhere within it. Many menu commands operate on the active pane.

The tool bar icons described in this section appear in the pane-specific tool bar for all pane types. Additional icons
specific to each pane type are also available.

Table E-1 Tool Bar Icons

DescriptionNameIcon

Opens the New Results Table wizard.New Results Table

Opens a Results Table.Open

Saves any open files.Save

Selects a project folder.Select Analyst Project

Locks the screen. This feature in available only when the Analyst
®

MD software is in Mixed Mode and the screen lock feature is
enabled.

Screen Lock

Shows the rows in the Results Table for both the currently
selected analyte and the corresponding internal standard. When
this option is selected, the user can click an analyte name and view
it with the internal standard. This is equivalent to clicking the
analyte and then clicking the internal standard while pressing Ctrl
(so that both are selected).

Show Internal Standard
with Analyte

Selects the items in the list that match the specified text.Find Component or Group

Changes the relative positions of the panes. Click the icon in one
pane and then drag it to the top, bottom, left, or right portion of a
second pane. Depending on where the cursor is released, the first
pane changes positions relative to the second. As the cursor is
dragged, one side of the second pane is highlighted in red to
indicate where the first pane will be drawn.

Arranging Panes

Deletes the pane. If a Results Table is deleted, then other related
panes (Peak Review and Calibration) are also deleted and the
entire window is closed.

Delete Pane
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Table E-1 Tool Bar Icons (continued)

DescriptionNameIcon

Maximizes the pane to fill the entire window (or vice versa). This
is useful if there are several panes in the window so that the user
can temporarily focus on one.

In zoomed mode, a separate tab appears at the top of the window
for each pane. Switch between panes by clicking the appropriate
tab. From zoomed mode, return to the original view showing all
panes by clicking Zoom Pane a second time. Clicking the icon
toggles between the two states.

Toggles tab mode

Hides the pane so that other panes in the window fill the available
space.

Hide Pane

Shows all panes that have been previously hidden.Show Hidden Panes

Table E-2 Peak Review Tool Bar Icons

DescriptionNameIcon

Shows the previous set of chromatograms. This is equivalent to
pressing the up or left arrow key, or clicking the upper arrow on
the scroll bar.

Display Previous Page

Shows the next set of chromatograms. This is equivalent to pressing
the down or right arrow key, or clicking the lower arrow on the
scroll bar.

Display Next Page

Scrolls backwards in the Peak Review pane. This is equivalent
to clicking the up arrow on the scroll bar until the first sample that
is different from the first currently visible chromatogram is shown.

Display Previous Sample

Scrolls to the next sample.Display Next Sample

Starts the slide show. On first use, the Slide Show Options
dialog opens. Set the delay time in seconds between peaks. To
prevent the dialog from opening again, select the Only show
this dialog again if the shift key is down check box. Click
anywhere in the Peak Review pane to stop the slide show.

Starts Slide Show Peak
Review mode

Enlarges the selected peak.Peak Magnifier

Returns the magnified peak to its original size.Peak Demagnifier
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Table E-2 Peak Review Tool Bar Icons (continued)

DescriptionNameIcon

Click to indicate that no peak is present in the active chromatogram.
In some cases when no significant peak is actually present, small
noise peaks might be integrated and reported. Click this icon to
override that behavior. The peak area shows in the Results Table
as N/A.

After the user marks the peak as Not Found, the peak-finding
parameters at the left of the pane are not available for the
chromatogram because they are not being used. Click the icon again
to return to automatic mode.

Set Peak to 'Not Found'

Click to enter manual integration mode. When the software is in
manual integration mode, drag in a chromatogram plot to specify
the exact region to be integrated. Integration starts from the (time,
intensity) point at which the cursor is first clicked and proceeds to
the point at which the cursor is released. Click the icon again to
exit manual integration mode.

After the user manually integrates the peak, the peak-finding
parameters at the left of the pane are not available for the
chromatogram because they are not being used. Click the icon again
to return to automatic mode.

Enable Manual Integration
Mode

Recalculates the peak model using the active chromatogram and
applies it to that chromatogram (SignalFinderTM integration
algorithm only).

Recalculate Peak Model

Table E-3 Calibration Tool Bar Icons

DescriptionNameIcon

Used to change the calibration parameters. This includes both the
actual parameter used for the regression (Area or Height) as well
as the regression type and weighting. Refer to Regression Equations
on page 128.

Edit Regression and
Weighting
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Table E-4 Statistics Tool Bar Icons

DescriptionNameIcon

The Statistics Table can be arranged so that samples (for a given
analyte) are grouped by actual concentration or by sample name.
When grouping by sample name, the Remove Trailing Index
from Sample Name option controls whether sample names
must match exactly in order to be grouped or whether a trailing
numerical index following a dash (-) should be removed. For
example two samples with names of Sample 1 - 001 and Sample
1 - 002 would be grouped together if this option were selected, but
not otherwise.

Remove Trailing Index from
Sample Name

The items in this list specify how the sample for a given analyte
should be grouped for the calculation of the statistics. The following
choices are available:

• Group by Concentration for Standards: Standard
samples are grouped by actual concentration.

• Group by Concentration for QCs: Quality Control
samples are grouped by actual concentration.

• Group by Sample Name for Standards: Replicate
Standard samples are grouped by the Sample Name field.
As described previously, if the Remove Trailing Index from
Sample Name option is not used, then the sample names
must match exactly. Otherwise, the names can differ by a trailing
number (following a dash).

• Group by Sample Name for QCs: Similar to the previous
option, except that only Quality Control samples are used.

• Group by Sample Name for All Samples: Similar to the
previous option, except that all samples are used.

Sample Grouping
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Table E-4 Statistics Tool Bar Icons (continued)

DescriptionNameIcon

The items in this list specify the actual metric that is used for the
calculation of the statistics. The following choices are available:

• Calculated Concentration: The Calculated
Concentration field of the Results Table is used.

• Area: The Area field of the Results Table is used.

• Height: The Height field of the Results Table is used.

• Calibration Y-Value: The regression parameter specified for
the analyte is used. This is either Area or Height for an analyte
that does not have a corresponding internal standard, or Area
Ratio or Height Ratio for an analyte that does use an internal
standard.

Metric

Table E-5 Results Table Tool Bar Icons

DescriptionTool TipIcon

Shows the Peak Review pane so that the quality of
the peak integrations can be checked and modified if
necessary.

Displays the peak review

Shows two sample lists so that users can select up to
six samples to compare the peak responses across the
samples.

Displays the side by side sample
review

Shows the calibration curve (this is only applicable if
Standard samples of known concentration are used).
This pane enables the user to review the calibration and
adjust the regression type and weighting.

Displays the calibration curve

Shows a metric plot for the currently selected column
or columns. These plots can be very useful for finding
outliers. The menu to the immediate right of the button
lists any saved plot settings.

Creates a metric plot

Shows the Statistics pane. This table shows the
average calculated concentration, standard deviation,
and CV for each concentration level.

Displays the statistics pane
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Table E-5 Results Table Tool Bar Icons (continued)

DescriptionTool TipIcon

Sorts the Results Table so that the values in the
selected column are in ascending order. This icon is
available only after the column header is clicked.

Sort selected column from
smallest to largest

Sorts the Results Table so that the values in the
selected column are in descending order. This icon is
available only after after the column header is clicked.

Sort selected column from largest
to smallest

If the table has been sorted, returns the Results Table
to the default order.

Removes any previous sorting

Filters the Results Table so that only samples of a
specific type are visible. This is only useful if there are
Standard samples of known concentration and not
all samples are Unknowns.

Shows only the selected sample
type(s)

Hides the selected rows in the Results Table. Select
the rows to hide and then click the icon.

Because the Peak Review pane synchronizes with
the Results Table, hiding rows for those peaks that
do not need to be reviewed makes the review process
faster. For example, the user can sort the table on the
Quality column and hide all rows with a quality greater
than some value (for example 0.8). The table can then
be sorted on the Region Height column and all rows
with a low value hidden (to hide rows for which the
peak is definitely not present). The result is that only
peaks with a low quality, but for which a peak is actually
present, are visible. The user can then step through these
visible rows from the Peak Review pane in less time
than it would take to review all possible peaks.

Hide selected row(s)

Shows all of the rows. The shown rows might still be
constrained by the Sample Type Filter and the
Components & Groups List selection.

Show previously hidden row(s)

Shows the rows that contain outliers.Show only outliers

Advances to the next outlier in the Results Table.Go to next outlier
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Table E-5 Results Table Tool Bar Icons (continued)

DescriptionTool TipIcon

Locks the Results Table after it has been saved.
Changes to the Results Table are not saved unless
the file is unlocked.

Lock and Save

Click to save the Results Table after it has been
reviewed. The icon is unavailable if the Results Table
is read-only.

Review and Save
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Note: When the MultiQuantTM MD software is removed, the MultiQuantTM MD software security items in the
Analyst

®
 MD software remain. Security permissions are found on the Roles tab in the Security Configuration

dialog.

DescriptionPreset Access

Allows users to create a Results Table.Create session file

Allows users to create quantitation methods.Create quantitation method

Allows users to modify the quantitation methods located in the
Quantitation Methods folder in the Analyst Data folder.

Modify quantitation method files

Allows users to export or create reports of unlocked Results Tables.Allow Export and Create Report of
unlocked Results Table

Allows users to update existing Results Tables but does not allow them
to create a new Results Table using an existing Results Table name.
For example, if a Results Table called RT1 is created, then users can update
it but they cannot create a new Results Table using the name RT1. Users
cannot name an untitled Results Table using an existing Results Table
name.

Replace existing Results Table
when saved

In the Integration Default dialog, allows users to change the algorithm.
Click Edit > Project Integration Defaults.

Change default quantitation
method integration algorithm

In the Integration Default dialog, allows users to change the algorithm
default parameters. Edit > Project Integration Defaults.

Change default quantitation
method integration parameters

Allows users to activate or deactivate the flag that enables the Project
Modified Peak Warning option on the Edit menu.

Allow Enable Project Modified
Peak Warning

If enabled, then data in the text file is encrypted during export. Set a password
to enable encryption.

Allow Project Secure Export
Settings

Allows users to add samples. Click Process > Add Samples.Add samples to Results Table

Allows users to remove selected samples. Click Process > Remove
Selected Samples.

Remove samples from Results
Table
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DescriptionPreset Access

Allows users to export, import, or remove an external calibration using one
of the following options:

• Click Process > Export Calibration.

• Click Process > Import External Calibration.

• Click Process > Remove External Calibration.

Export, import, or remove External
Calibration

Allows users to modify the project audit map and modify the audit map
definition. Click Audit Trail > Audit Map Manager.

Change Audit Map settings

Allows users to modify the sample name in the Results Table.Modify Sample Name

Allows users to modify the sample type (Standard, QC, Unknown) in
the Results Table.

Modify Sample Type

Allows users to modify the sample ID in the Results Table.Modify Sample ID

Allows users to modify the actual concentration of the Standard and QC
in the Results Table.

Modify Actual Concentration

Allows users to modify the dilution factor in the Results Table.Modify Dilution Factor

Allows users to modify comment fields:

• Component Comment

• IS Comment

• IS Peak Comment

• Peak Comment

• Sample Comments

Modify Comment Fields

Allows users to enable manual integration mode in the Peak Review pane.
If this permission is enabled, then the Modify Results Table integration
parameters for a single chromatogram permission must also be
enabled. The Allow manual integration command can be disabled if
the Modify Results Table integration parameters is enabled.

Allow manual integration

Allows users to use the Set peak to not found . To perform this action,
right-click in the Peak Review pane.

Allow set to Peak Not Found

Allows users to include or exclude peaks from Results Tables, Statistics
Tables, and calibration curves.

Include or exclude a peak from the
Results Table

Allows user to modify the regression settings in the calibration curve pane
when using the Modify Results Table Method functionality and when
using the New Quantitation Method wizard.

Modify regression settings for fit
and weight
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DescriptionPreset Access

Allows user to modify a single chromatogram.Modify Results Table integration
parameters for a single
chromatogram

Allows user to apply the modifications from the single chromatograms to the
component.

Users must have this permission and the Modify Results Table
integration parameters for a single chromatogram permission
enabled if they want to update and then apply single modifications to
components.

Modify quantitation method for
the Results Table component

Allows users to create and use metric plots in the Results Table (Metric
Plot button is enabled) or export metric plots. Click File > Export.

Create, use, or export Metric Plots
in Results Tables

Allows users to modify the Peak Review Title Format in Peak Review.
To perform this action, right-click in the Peak Review pane.

Set Peak Review Title Format

Allows users to add, rename, or modify a custom column. Even without this
permission, users can run queries that will automatically create custom
columns.

If this permission is disabled, then the Remove custom column
permission must also be disabled. The Remove custom column can be
disabled if the Add, Rename, or Modify custom column permission
is enabled.

Add, Rename, or Modify custom
column

Allows users to delete a custom column in the Results Table.Remove custom column

Allows users to modify Results Table column settings within a Results
Table.

Modify Results Table column
settings

Allows users to apply the column settings to the project.Save Column Settings as Project
Default

Allows users to lock and save a Results Table.Lock and save Results Table

Allows users to unlock and save a Results Table.Unlock and save Results Table

Allows users to review and save the Results Table.Review and save Results Table

Allows users to edit the Report templates.Edit Report Template

Allows users to transfer saved and locked Results Table to a LIMS. The
event is recorded in the audit trail.

Transfer to LIMS
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Security Settings
Table F-1 contains the recommended security settings for the user roles.

Table F-1 Security Settings Based on User Roles

ReviewerAnalystSupervisorAdministratorSecurity Setting

No AccessAccessAccessAccessCreate session file

No AccessNo AccessAccessAccessCreate quantitation
methods

No AccessNo AccessAccessAccessModify quantitation
method files

No AccessNo AccessAccessAccessAllow Export and Create
Report of unlocked
Results Table

AccessNo AccessAccessAccessReplace existing Results
Table when saved

No AccessNo AccessAccessAccessChange default
quantitation method
integration algorithm

No AccessNo AccessAccessAccessChange default
quantitation method
integration parameters

No AccessNo AccessNo AccessAccessAllow Enable Project
Modified Peak Warning

No AccessNo AccessNo AccessAccessAllow Project Secure
Export Settings

No AccessAccessAccessAccessAdd samples to Results
Table

No AccessAccessAccessAccessRemove samples from
Results Table

No AccessNo AccessAccessAccessModify Sample Name

No AccessAccessAccessAccessModify Sample Type

No AccessNo AccessAccessAccessModify Sample ID
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Table F-1 Security Settings Based on User Roles (continued)

ReviewerAnalystSupervisorAdministratorSecurity Setting

No AccessAccessAccessAccessModify Actual
Concentration

No AccessAccessAccessAccessModify Dilution Factor

No AccessNo AccessAccessAccessModify Comment Fields

No AccessAccessAccessAccessAllow manual
integration

No AccessAccessAccessAccessAllow set to Peak Not
Found

No AccessAccessAccessAccessInclude or exclude a
peak from the Results
Table

No AccessNo AccessAccessAccessModify regression
settings for fit and
weight

No AccessAccessAccessAccessModify Results Table
integration parameters
for a single
chromatogram

No AccessAccessAccessAccessModify quantitation
method for the Results
Table component

AccessAccessAccessAccessCreate, use, or export
Metric Plots in Results
Tables

No AccessNo AccessNo AccessAccessSet Peak Review Title
Format

No AccessNo AccessAccessAccessAdd, Rename, or Modify
custom column

No AccessNo AccessAccessAccessRemove custom column

No AccessNo AccessAccessAccessModify Results Table
column settings

No AccessNo AccessAccessAccessSave Column Settings as
Project Default
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Table F-1 Security Settings Based on User Roles (continued)

ReviewerAnalystSupervisorAdministratorSecurity Setting

AccessAccessAccessAccessLock and save Results
Table

No AccessNo AccessAccessAccessUnlock and save Results
Table

AccessNo AccessAccessAccessReview and save Results
Table

No AccessNo AccessAccessAccessModify Report Template

AccessNo AccessAccessAccessTransfer to LIMS
(Controls Initiate
Transfer to Watson LIMS
as well)

No AccessNo AccessAccessAccessExport, import, or
remove External
Calibration

No AccessNo AccessAccessAccessChange Audit Map
Setting
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DateReason for ChangeRevision

September 2013First release of document.A

January 2015Updated File Menu section. Updated Audit Trail Menu section. Updated Results
Table Columns table. Updated Reports section.

B

June 2017Changed AB SCIEX logo to SCIEX Diagnostics on the cover page. Updated the
copyright page and changed AB Sciex to SCIEX where required. Added Windows
10 to the Introduction to the Software chapter. Updated the Contact Us section.
Changed Topic title Audit Map Manager to About Audit Maps. Updated the
description of the Set Last Component of Group as IS menu option in the Internal
Standards Submenu section. Replaced "total area percentage parameter" with
the "retention time" in the Update Retention Time Dialog section. Updated the
description of Expected RT in the SignalFinder Integration Algorithm Parameters
section. Added Windows 10 to the Create Reports section. Updated the content
in the Report Template Tags section. Changed the screenshot in Figure 7-3.
New templates were applied to the content, which has led to some edit changes
in the content. Removed all references to Windows XP.

C
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